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Notice 
We make every effort to provide the latest 
technical documentation. There may be 
updates. For this, please contact NORBIT 
Support for the latest information. 
 

Copyright Statement 
Copyright 2017 by NORBIT. All rights 
reserved. This publication may not be copied, 
translated, reproduced or transmitted in any 
electronic form, without prior written consent 
from NORBIT. 
 

Disclaimer 
While every effort is made to ensure the 
information given is accurate, NORBIT does 
not accept liability for any errors or omissions. 
All non-metric weights and measurements are 
approximate. Specifications, equipment, and 
other information in this document are subject 
to change without notice. 
 
All performance metrics mentioned in this 
document, such as attainable depths, was 
derived from tests in Portland, Oregon and 
Seattle/Tacoma, Washington, USA in May 
2017. Acoustic conditions are described when 
describing performance capabilities. 
 

Sonar Kits 
This manual covers the following NORBIT 
products: 
 
WINGHEAD Series 
WINGHEAD i77h 
WINGHEAD B41 
 
WBMS Series 
iWBMSh/STX 12007 
iWBMS/STX 12004 
iWBMSe  12006 
WBMS  12003 
 

Software Release 
NORBIT GUI Version: 10.4.8 
Firmware Version: 5.2.1 

 

Release Notice 
This is the September 11, 2020 release of 
the NORBIT sonar user and technical 
manual. 
 

 

 Contact Information 
NORBIT Subsea AS 
Stiklestadveien 1 
7041 Trondheim 
Norway 
 
Phone: +47 739 82 569 
Support: https://norbit.com/subsea/support/ 
Email: subsea_support@norbit.com 
Web: https://norbit.com/subsea/ 
 

 

 

 

https://norbit.com/subsea/support/
mailto:subsea_support@norbit.com
https://norbit.com/subsea/
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 Introduction 

1.1 Terms & Abbreviations 

 

AMPS Amperes 
Aux Auxiliary 
Bandwidth Range of frequency sweep 
CoR Center of Rotation (or Center of Gravity) 
CW Continuous Wave (single frequency) 
DCT Data Collection Tool 
EA Equal Angle beam distribution 
ED Equal Distance beam distribution 
FM Frequency Modulation (swept frequency) 
GAMS GNSS Azimuth Measurement Subsystem 
GNSS Global Navigation Satellite System 
GPS US Global Positioning Satellites (often describes all GNSS) 
GUI Graphical User Interface 
IHO International Hydrographic Organization 
IMU  Inertial Motion Unit 
INS Inertial Navigation System 
iSIU Integrated SIU 
iWBMSe Integrated WBMS – Entry Level (SurfMaster) 
iWBMS Integrated WBMS – Standard (mid-grade with WaveMaster) 
iWBMSh Integrated WBMS – Pro (with top level OceanMaster) 
LED  Light Emitting Diode 
MBES Multibeam Echosounder Sonar 
NTP Network Time Protocol 
POS Positioning & Orientation System 
PPK Post Processed Kinematic 
PPS Pulse Per Second 
PTP Precise Time Protocol 
RTK Real Time Kinematic 
Rx Receive 
SBAS Satellite Based Augmentation System 
SIU Sonar Interface Unit 
SNR Signal to Noise Ratio 
SONAR Sound Navigation and Ranging 
STX Steerable Transmission 
Tx Transmit 
USACE USA Army Corps of Engineers 
VDC Volts – Direct Current 
WBMS Wideband Multibeam System 
WINGHEAD B41 WINGHEAD Multibeam 
WINGHEAD i77h Integrated WINGHEAD Multibeam – Pro (with top level OceanMaster) 
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1.2 Technical Overview 

NORBIT sonars are the most compact, high resolution, wide swath multibeam sonars available. With 
a dry-weight of less than 4.5kg (10lbs), beam widths of only 0.5° at 400kHz, and low power 
consumption, the stand-alone multibeam sonar easily mounts to a survey platform of any size. 
 
NORBIT’s sonar technology is unique to the industry as the first platform designed as a cylindrical 
array wideband system with frequency modulated (FM) transmission. From the returning signal, 256, 
512 or 1024 beams are formed within a user-selectable 5° to 210° fan-shaped swath. NORBIT has 
implemented cutting edge signal gain compensation, adaptive gating/thresholding, steerable 
transmission capability, and proprietary amplitude and phase detection algorithms to achieve 
accurate and repeatable bottom detections.   

 
All processing and export of time-stamped bottom detection occurs within the sonar head. The 
system requires very little user intervention to achieve clean and repeatable bathymetry. Hardware 
installation is similarly easy and quick. A single cable powers and connects the sonar to a small 
Sonar Interface Unit (SIU). The SIU connects to a data acquisition PC by a single Ethernet cable. 
 
With latest FPGA circuits, integrated surface sound speed probe, and 21st century engineering, 
NORBIT systems provide the resolution and capabilities of much bulkier systems. Efficiency savings 
begin with the installation: the compact (and lightweight) form-factor enables for simpler mounting 
infrastructure than earlier generation box-shaped multibeam sonar systems. Low power 
requirements allow added flexibility on very small survey vessels as well as any vessel of 
opportunity. 

 
NORBIT offers many options for a tightly integrated bathymetric mapping solution that combines all 
sensors required to carry-out high-grade bathymetric surveys. The integrated systems, with a 
complete GNSS/INS system, drastically streamline the setup process and reduces measurement 
uncertainties. 
 

 
 

1.3 NORBIT WINGHEAD Series & WBMS Series 

NORBIT sonars are based on a state-of-the-art analogue and digital platform featuring powerful 
signal processing capabilities, offering high resolution bathymetry and several imagery and 
backscatter outputs, ensuring the highest quality survey data performance.  
 
The WINGHEAD series has a receiver beam width of just 0.5⁰ at 400kHz and is the first cylindrical 
ultra-high-resolution bathymetry product on the market. Both the WINGHEAD and WBMS series are 
available in a range of configurations, both as standalone sonars and with tightly integrated 
GNSS/INS systems. 

Laptop or PC 

Sound Velocity Profiler 

Primary GNSS Antenna 

Secondary GNSS Antenna 

LiDAR (Optional) 

RTK Corrections 
(Optional) 

Multibeam 

Ethernet 
Interface 
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 NORBIT 
 WINGHEAD 

 

 

 NORBIT 
 WBMS 

 

 

 
Ultra High-Resolution Curved Array 

Bathymetry System 
 Wideband Multibeam Sonar for High 

Resolution Bathymetry 

0.5 x 0.9⁰ at 400kHz 
0.3 x 0.5⁰ at 700kHz 

 

 
0.9 x 0.9⁰ at 400kHz (Narrow TX) 
0.5 x 0.5⁰ at 700kHz (Narrow TX) 

 WINGHEAD i77h 
WINGHEAD B41 

  iWBMSh      iWBMS 
iWBMSe      WBMS 

 

1.4 Advantages of the Cylindrical Array 

• Unlike a flat array, bottom detections from a cylindrical array are much less susceptible to 
surface sound speed errors. 

• Due to proprietary progressive beamforming techniques supported only by cylindrical arrays, 
NORBIT sonars form narrower beams than flat arrays, resulting in superior bathymetry quality. 

• At all frequencies, NORBIT sonars provide increased swath coverage with a smaller beam 
footprint for a fixed aperture. 

• The cylindrical array of the NORBIT sonars can cover a full 210°. Flat array systems would lose 
data fidelity at much lower swath angles (± 80°) and would necessitate mounting two or three 
sonars at angles to achieve higher swath coverage. 

• The cylindrical array presents a more hydrodynamic profile allowing for faster transit, less 
vibration, and use of lighter mounting hardware. Sturdier mounting, such as hull mounts, enables 
a maximum transit speed of >20 knots. 

1.5 Advantages of the Integrated INS 

Factory integration of critical sensors provides several benefits. Offsets between the sonar and 
inertial navigation system are fixed and predefined within the system setup. The user need only 
measure the offset to the bottom of the primary GNSS antenna. 
 
Cabling and software integration between the sonar, positioning, heading, attitude and sound speed 
probe is handled internally. The onboard surveyor need only connect the wet end to the topside via 
a single cable and then connect the primary and secondary GNSS cables (which are each labelled 
on both ends of the cable to remove installation uncertainty). 

1.6 Advantages of Steerable Transmission (STX) 

The NORBIT STX is a steerable projector system that allows the transmit beam to be directed ±10° 
in a scanning pattern. In its most basic configuration, this scanning allows the system to ensonify 
areas that otherwise would not be. This functionality aids inspection surveys by giving a more 
complete picture of the survey area or target. Additionally, it can be used to capture extra detail on 
complex structures, such as shipwrecks, during a single pass. 
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Scanning can be activated by the user at any time. The user defines a step size, and each step 
angle occurs with each ping. The time to complete a full scan depends on the current ping rate, for 
example a ping rate of 20Hz, and a step size of 20, means 1 second per scan. 

 

 
 
STX can be used for many applications, including obstacle avoidance, dredge monitoring, and cable 
lay operations. It can be mounted in any orientation to change the scanning pattern. For example, a 

90° rotation in heading and upward tilt allows the sonar to scan a ±10° sector ahead of the vessel. 

 
The special STX 360 configuration integrates the STX with a rotator to provide 360° real-time 

coverage from a static platform. This provides rapid and efficient dredge monitoring compared to 
conventional methods, since no sailing is required. 

1.7 System Specifications  

While continual improvements are being implemented, specifications may change. To obtain the 
most current specification sheets please visit https://www.norbit.com/subsea/ 

1.8 Export, Shipping Weight & Dimensions 

The compact size of the NORBIT systems allows for simplified shipping and handling. The lightest 
NORBIT system wet-end is the 0.9° x 1.9º WBMS at 4.5kg in air while the heaviest system is the 
0.9° x 0.9º iWBMSh, which weighs 11kg in air and 7kg in water. 

 ITAR Restrictions 

All systems are free of Canadian and EU export controls. When exported from the U.S., the U.S. 
Department of Commerce ECCN 7A994 reference number needs to be quoted on all shipping 
documentation. 
 

⚠ 
 

CAUTION:  Shipping Internationally from USA 

Shipping documents should quote ECCN 7A994. This number is the same 
for all NORBIT systems.  NORBIT recommends DHL as a preferred shipper 
when shipping internationally. 

 

Piling 

Piling 

Forward sweep ensonifies area behind the 
piling before the vessel is adjacent to it 

Aft sweep ensonifies area behind the 
piling again after the vessel has passed it 

D
ire

c
tio

n 

Approaching 

Retreating 

https://www.norbit.com/subsea/
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 Shipping  

Each standard NORBIT system (including all components) are shipped in a single, lightweight 
Pelican case that meets airline baggage guidelines.  
 
Airline Checked Luggage: Despite the rugged freight case construction with dense form-cut foam 
shock absorption, it is prudent to handle the full cases with care. Please ensure an airline “Fragile” 
label is prominently displayed. 
  
Airline Carry-On Baggage: The sonar case may be hand-carried onto many airplanes but when 
checking through airport security it is often required to remove the sonar from the case for x-ray. 

1.9 Caring for Your Investment 

Take care when handling the sonar, and use “Fragile” labels when shipping via courier. Never 
support the NORBIT sonar by the sound speed probe or strictly by the projector, and do not allow 
the wet end to rest on the polyurethane as this may scratch or wear this sensitive area.  When 
mounting the sonar, always use a sturdy padding (foam) underneath it. For the stand-alone WBMS 
sonar, when shipping in a non-foam cut case, remove the sound speed probe and replace it with the 
blue dust cap. For WINGHEAD sonars, the sound speed probe should never be removed. 

 
Do not leave the system in the sun for long durations. Prolonged exposure to UV rays may cause 
degradation of the polyurethane coating on the transducers; potential damage includes drying and 
crack formation which would permanently expose and damage sensitive sonar electronics. 
 
 

⚠ 
 

CAUTION:  Sonar Protection & Biofouling 

When submerged for long periods, the sonar is at risk of biofouling. 
(especially in warm salty water) or may be subjected to stray electric 
currents. NORBIT offers both titanium housing, additional anodes and 
factory applied bio-fouling paint that is tested against acoustical losses. 

 
 

To clean the NORBIT sonar, only use mild, nonabrasive soap, fresh water, and a soft brush to gently 
scrub the sonar. Do not use a pressure washer to clean the sonar, as this can damage the housing. 
To protect the system from corrosion, take extra care when handling to not scratch the anodized 
aluminum housing (not a concern for titanium housing). It is also good practice to rinse off the sonar 
after use, especially if used in saltwater, and allow it to dry completely prior to storage. 

 
If the sonar will be in the water for extended periods, it is recommended that sacrificial anodes be 
used to protect against electrolysis. Anodes can be collared around the cable connection and 
inserted into the receiver frame. Care must be taken to not scratch the anodizing on the aluminum 
housing during installation. Spare anodes can be purchased directly from NORBIT. 
 
If your system is protected with antifouling paint then additional care is required to ensure the paint 
is not scraped or degraded during mobilization, shipping or handling. After retrieving the sonar from 
the water, wipe down the system with a clean towel to clear off dirt, grime, marine growth, etc. that 
may otherwise compromise the sonar. 
 
 

⚠ 

CAUTION:  Do Not Connect or Disconnect Cables with Power On 

To prevent damage to system electronics, always turn off power before 
disconnecting or swapping cables. 
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1.10 Maintenance Schedule 

It is good practice to perform periodic inspections or checks of the sonar system. The table below 
lists several checks, recommended by NORBIT, to guide users in performing maintenance checks. 

 Before Each Survey 

Component Inspection Additional Notes 

Receiver Array Inspect polyurethane for gouges, nicks or 
separation from housing. The array face should 
be smooth and uniform. 

Water intrusion will result in damage 
and be costly to repair. Always store 
sonar away from sun. 

Projector Array Inspect the projector array for gouges or nicks 
and check the attachment area of the projector 
with the sonar housing. The projector surface 
should be smooth and uniform. 

Water intrusion will result in damage 
and be costly to repair. Always store 
sonar away from sun. 

O-Rings on wet 
end cable 
connections 

Check O-rings for damage and particulates that 
may interfere with O-ring operation and keep it 
lightly lubricated. Use Silicone Grease that is 
min. 90% pure. 

If missing a spare O-ring, please 
remove and borrow one from the 
cable wet-end protective cap and 
contact NORBIT Support for 
replacements. 

WBMS Sound 
Speed Probe 

Remove sound speed probe and check 
connector for corrosion. Probe O-ring should be 
in good condition. Replace probe and ensure a 
tight fit. Apply light coating of silicone grease to 
O-ring prior to re-attaching probe. Compare 
value with corresponding value from profiler at 
same depth. Difference should not exceed 1m/s. 

Bad or missing surface sound 
speed will create beam steering 
errors and affect outer swath data 
performance. It is recommended 
that the probe be calibrated every 
18-24 months. WINGHEAD probes 
should never be removed. 

Sonar Housing Inspect housing for scratches and corrosion.  
Ensure anode is in good condition (for aluminum 
housing). 

Small scratches compromise the 
galvanic barrier of the aluminum 
housing. 

Sonar 
Connector 

Check for debris and clean with compressed air. 
Cable connector must be dry and clean. Use 
protective cap when not in use. 

Sonar connection is not wet-
mateable. Do not disconnect or 
connect when sonar is submerged 
or in wet areas.  

Sonar Cable Check connectors and clean with compressed 
air. Run cable through hand and check that 
cable is smooth, without kinks and tears. Check 
that pins are shiny and not bent. Check O-rings 
for wear and replace as necessary. Use small 
amount of silicone lubricant. 

A bad connection or bad cable will 
corrupt survey data. Treat the cable 
with great care (do not stand on it). 

Sonar Mounting 
Bolts 

Check that threads on plastic sleeves are intact 
and not de-threaded. Vibration over long term 
can loosen bolts and compromise data quality or 
loss of wet-end. 

Use only stainless-steel bolts and 
washers. Use Loctite 242 Blue, lock 
washers and/or nylon nuts. 

Mounting 
Bracket 

Check that all hardware for the mounting bracket 
is tight. Care must be taken when checking the 
mounting screws for the sonar as over tightening 
may damage the connections. 

The bracket is very robust and 
provides electrical isolation from the 
vessel. 

Electrical & 
Galvanic 
Isolation Shield  

Check that plate is included in shipping case and 
used between sonar and sonar bracket when 
mounted. For the WBMS (non-integrated 
systems), it is imperative to use the included 
electrical isolation shield. 

This protects the aluminum sonar 
housing from galvanic corrosion. 

Firmware & 
GUI Versions 

Ensure that both firmware and GUI versions 
match and are latest. This may require an 
annual maintenance cost. 

Contact NORBIT Support for 
details. 
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 After Each Survey 

Component Inspection Additional Notes 

Complete Kit Perform all inspections in the previous section.  Store the system in a dry location at 
room temperature. 

Wet-End The wet end should be rinsed with fresh water. 
Clean off marine growth with a soft rag. If 
barnacles are present, remove them carefully so 
as not to pit or nick the polyurethane. If any 
damage occurs to the anodized aluminum or 
polyurethane, send photos to NORBIT Support 
for analysis. Allow the kit to dry before storing. 
Once back at the office, store with lid open. 

When not in use, the sonar cable 
(and IMU cable for integrated 
iWBMS systems) should be secured 
with the included protective caps. 
The length may be adjusted by 
grabbing one of the collars and 
pulling on the cable. 

 Monthly 

Component Inspection Additional Notes 

Complete Kit Perform all inspections in the previous sections.  Ensures that users are ready for the 
next survey. 

Sound Speed 
Probe 

Compare surface sound speed probe with another 
sensor. If the difference exceeds 1m/s and the 
comparison conditions are similar, determine 
which sensor is bad and return for calibration. 

The surface sound speed sensor 
should provide reliable data for an 
18-24-month period. 

 Annually 

Component Inspection Additional Notes 

Complete Kit Perform all inspections in the previous sections. 
NORBIT offers factory health checks or on-site 
system health checks. The factory health check is 
recommended as it allows a full system inspection 
and calibration service to be performed, whereas 
the on-site health check is limited. A factory health 
check is recommended every two years. 

Calibration service includes surface 
sound speed calibration. Contact 
NORBIT Support for details on our 
factory health check. It is the 
responsibility of the user to 
schedule the calibration. 

 

1.11 Cleaning Hull-Mounted & Bio-Fouled Systems 

 

⚠ 
 

CAUTION:  Do NOT Use Pressure Washer 

The sonar is a very delicate instrument. To prevent damage, do not use a 
pressure washer, and only scrub the sonar using super fine abrasive pads, 
such as 3M™ Scotch-Brite™ Light Cleansing Hand Pad 7445. 

 

 

1. Remove the system from the vessel and secure dust resistant caps on the sonar bulkhead 
and cable. 

2. Remove as much fouling from the sonar as possible by hand. 

3. Obtain a bucket large enough to fit the entirety of the sonar. In the container, mix in a 50/50 
ratio of CLR® (Calcium, Lime, Rust cleaner) to water.  

4. With the bulkhead cap tightened, completely submerge the system in the 50/50 solution for 
approximately 2 hours. 

5. Remove the sonar from the solution and scrub the sonar using a super fine abrasive pad 
and water. 
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6. If fouling remains, repeat the soaking process. This process can be repeated until all 
biofouling has been removed from the system. 

7. Allow the system to dry fully prior to storage. 

1.12 Support 

NORBIT operates an online helpdesk, powered by Atlassian JIRA, that is monitored 24 hours a day, 
7 days a week. The global hotline is also available 24/7 for urgent matters. For basic support issues, 
please refer to the Troubleshooting section before contacting NORBIT Support. 
 
To raise a support request, visit the NORBIT helpdesk to register an account and create a ticket. 
After logging in, select “Technical Support” and complete the form. Each ticket is assigned a unique 
ID (NSS-XXXX) which must be included in the email subject if replying to the ticket from a regular 
email client. A support engineer will be assigned to your case and will contact you shortly. 

 
Please include as much information as possible when contacting NORBIT Support: 

• Your name and organization 

• NORBIT system model and serial number 

• Software versions 

• Detailed description of the problem or request 

• Relevant screenshots, error messages and system logs (see section 4.6.5.4) 

• For INS faults and data quality issues, send the raw INS data, stored at: 
C:\Users\<user>\Norbit\WBMS\Applanix Logs\ 

• Details and photos of the installation, if relevant 

• Data samples if relevant. Raw data recordings from the GUI should include water column 
data (enable the “View WC” checkbox under Backscatter Controls) 

The JIRA helpdesk can also be used to request a service RMA. 
 
When emailing the NORBIT Support address directly, a JIRA ticket will automatically be created and 
NORBIT will generate an account for you. To access the ticket, visit the helpdesk and select the 
“Forgot your password” link to reset your password. 
 

 
NORBIT Subsea AS 
Stiklestadveien 1 
7041 Trondheim 
Norway 

Phone: +47 739 82 569 (UTC+2) * 
Support: https://norbit.com/subsea/support/ 
Email: subsea_support@norbit.com 
*UTC time offsets above may be ±1hr off due to 
daylight savings time 

 
 
 
 
 

 
 
 
 
 
 
 
 
 

 

https://norbit.com/subsea/support/
mailto:subsea_support@norbit.com
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 Hardware Installation 

For well-seasoned multibeam users, the Quick Start can be used. All first-time NORBIT sonar 
operators, however, are strongly encouraged to fully review this manual prior to commencing a 
survey project. The warning boxes may not cover all critical notices. 
 
 

⚠ 

NOTE:  Subsea (ROV/AUV) and USV Installations 

For ROV/AUV/USV installations, please consult the technical note (TN-
190041) for integration guidance. Contact NORBIT Support if you do not 
have this document. 

 

2.1 Power Requirements 

NORBIT sonars require clean power for proper operation. As most vessels utilize an inverter for this 
purpose, it is important that it be a true sine wave inverter. A modified sine wave inverter may 
cause unexpected behavior, even when using the included power brick. In general, inexpensive 
inverters are likely modified sine wave. Use high quality inverters for providing power to the NORBIT 
sonar. If dirty power is assumed, connect the system directly to a 12-24VDC battery and test.  
 
Additionally, power can be provided directly from a 12V deep cycle battery using the included pigtail 
that plugs into the power port on the SIU. 

 Power Consumption 

Contact NORBIT Support if your power requirements dictate a lower power consumption. 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

System Average Maximum 

WINGHEAD B41 TBC 75W 

WINGHEAD i77h TBC 90W 

WBMS Bathy (12003) 40W 55W 

WBMS STX (12003) 50W 65W 

WBMS Bathy Long Range (12003) 40W 60W 

iWBMSe / iWBMSe Long Range (12006) 55W 70W 

iWBMS / iWBMS Long Range (12004) and iWBMSh (12007) 60W 75W 

iWBMSh STX (12007) 70W 80W 

iWBMSh Dual Head (12007) 100W 160W 
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2.2 Wet-End Overview 

NORBIT can provide 3D models of transducers, in the STEP file format, to support your installation 
plan. For such requests, please contact NORBIT Support. 
 
 

⚠ 

CAUTION:  Properly Seal Wet-End Connection 

Always inspect O-Ring before connecting wet-cable and replace as needed. 
Apply a thin coat of synthetic grease (e.g. Molykote 55) to O-Rings. Strongly 
hand-tighten wet-connector (push in and tighten until firmly connected). If the 
connector sticks, apply a very thin coat of grease to the threads. 

 

 WINGHEAD B41 & WINGHEAD i77h 

WINGHEAD B41 is a standalone sonar, whereas WINGHEAD i77h contains the well-known 
Applanix GNSS/INS system. All sonar processing occurs in the sonar head. Dimensions are the 
same for both models. 

 

 

 
 
The WINGHEAD i77h contains the Applanix OceanMaster (AP-30). This MEMS-based IMU is 
housed inside the projector of the wet end assembly, resulting in a very compact form factor. The 
systems are optionally available with POSPac MMS for full positioning and attitude PPP or PPK 
solutions. 
 

Anodized 
Aluminum Housing 

Cylindrical Receiver Array 
Projector Array 

Mounting Bracket 

Side View 

Cylindrical Receiver Array 

Sound Speed Probe 

Sonar Connector 
(single cable carries 

sonar and optional 
IMU data) 

Mounting Bracket 

Perspective 
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 iWBMS, iWBMSh & STX 

iWBMS, iWBMSh, iWBMSe and STX models contain the well-known Applanix GNSS/INS systems. 
The systems are optionally available with POSPac MMS for full positioning and attitude PPP or PPK 
solutions. The IMU is housed inside the ballistic grade front fairing of the wet-end assembly. 
 
 

 

iWBMS with standard 1.9°projector. The 0.9° projector adds only 10cm to the length. 

 iWBMSe 

The iWBMSe contains the Applanix SurfMaster (AP-18). The IMU is housed inside the projector of 
the wet end assembly resulting in a very compact form factor. The IMU may be optionally mounted 
on the front nose (like the iWBMS/iWBMSh) so that it may be easily upgraded later. The system is 
optionally available with POSPac MMS for a full positioning and attitude PPK solution. 
 

 

 

 WBMS 

The WBMS is the most basic model of the WBMS series, containing only a sonar. The receiver 
housing contains FPGA boards where all sonar processing occurs. 
 

 

IMU Cable 

IMU Inside 
Front Fairing 

Sonar Cable 

Delrin Mounting Bracket 

Projector Array 

Sound Speed Probe 

Delrin Mounting Bracket 

IMU Inside Projector 

Projector Array 

Cylindrical Receiver Array 

Sonar Cable Connector 
(always inspect the O-
ring, lubricate and 
replace as necessary) 

Sound Speed Probe 

Anodized Aluminum 
Housing 



 
 
 
 

 

Sonar User Manual                                            Contents September 11, 2020 
GUI: 10.4.8 / FW: 5.2.1   Page 17 of 103 

 

2.3 Dry-End Overview 

All NORBIT systems include a compact topside Sonar Interface Unit (SIU) which distributes power, 
time information and data between the sonar wet-end and the survey acquisition system. This 
environmentally sealed fan-less topside is dust-proof and splash resistant. The SIU will shut down 
automatically at 70°C to prevent damage to electronics due to overheating. 
 
 

⚠ 
 

CAUTION:  Voltage Ratings 

The DB9 and PPS connections on the SIU are not rated for voltages higher 
than 5V, and exceeding this could damage the system. Check all potential 
connections for unexpected voltages. 

 
 

⚠ 

CAUTION:  Cover Connection Ports 

When operating in open environments, all connection ports on the SIU 
should be tightly sealed either with the NORBIT supplied cables or, if the 
port is unused, with the port covers provided with the system. 

 

 WINGHEAD Integrated Sonar Interface Unit (iSIU-WH, PN 29060) 

 

 
 

 
  

 
 
 
 
 
 
 
 
 

 
* NORBIT offers a split serial option, which allows ASCII/Binary output of GNSS/INS information for up 
to 3 serial connections. Contact NORBIT Support for more information. 
 

Connector Description  

Sonar 18-pin interface to sonar and IMU 

Ant 1 Primary GNSS antenna 

Ant 2 Secondary GNSS antenna 

COM (Serial) GNSS corrections input (RTK/DGNSS) 

PPS 1PPS output for external sensor (not typically used) 

Ethernet For communication between topside PC and sonar 
(SAMTEC Part# RCE-01-G-05.00-D) 

Aux In/Out 10-pin interface for communication with auxiliary devices 

10-28 VDC Input DC voltage 
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 WINGHEAD Sonar Interface Unit (SIU-WH, PN 29064) 

 

 
 
 
 
 
 
 
 
 

 
 

 iWBMS, iWBMSh, iWBMSe & STX Sonar Interface Unit (SIU-I-NAV, PN 29028) 

 

 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
* NORBIT offers a split serial option, which allows ASCII/Binary output of GNSS/INS information for up 
to 3 serial connections. Contact NORBIT Support for more information. 
** SIU-I-NAV revisions 29028-5 and newer have an internal 20A fuse instead of the 12A fuse at the rear. 
 

The STX model, in bathy mode, may be coupled to another NORBIT sonar to form a dual-head 
system for increased coverage and faster results. However, due to the STX’s higher power 
requirements, a dual-head system compromising at least one STX will require two topside units. 

Connector Description  

Sonar 10-pin interface to sonar 

COM (Serial) NMEA ZDA timing input  

PPS 1PPS input for timing 

Ethernet For communication between topside PC and sonar 
(SAMTEC Part# RCE-01-G-05.00-D) 

Aux In/Out For communication with auxiliary devices 

10-28 VDC Input DC voltage 

Connector Description  

Sonar 18-pin interface to sonar and IMU 

Ant 1 Primary GNSS antenna 

Ant 2 Secondary GNSS antenna 

COM (Serial) GNSS corrections input (RTK/DGNSS) 

PPS 1PPS output for external sensor (not typically used) 

Ethernet For communication between topside PC and sonar 
(SAMTEC Part# RCE-01-G-05.00-D) 

Aux In/Out 10-pin interface for communication with auxiliary devices 

10-28 VDC Input DC voltage 

Fuse Socket** 12A slow blow (Rear of unit) 
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 WBMS Sonar Interface Unit (SIU, PN 29024) 

 

 
 
 
 
 
 
 
 
 
 

 
* SIU-I revisions 29024-5 and newer have an internal 20A fuse instead of the 6A fuse at the rear. 
 

This SIU works with all WBMS Bathy, STX and FLS systems. The iWBMSe requires an 18-pin to 
10-pin adaptor. 

 Aux In/Out Port 

The 10-pin Aux port on the integrated SIU allows users to expand NORBIT sonar capabilities by 
integrating additional sensors. For the full pin description, refer to the appendices at the end of the 
manual. The Aux port can connect to an additional sonar to operate in a traditional dual head 
configuration with either sonar projecting down, or one looking forward for obstacle avoidance in 
challenging environments.  This port can also communicate with the iLiDAR, a topographic laser, to 
simultaneously collect multibeam and topographic data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Connector Description  

Sonar 10-pin interface to sonar 

COM (Serial) NMEA ZDA timing input  

PPS 1PPS input for timing 

Ethernet For communication between topside PC and sonar 
(SAMTEC Part# RCE-01-G-05.00-D) 

Aux In/Out For communication with auxiliary devices 

10-28 VDC Input DC voltage 

Fuse Socket* 6A slow-blow (Rear of unit) 
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 LED Status Indicators 

All SIU versions have activity LEDs that behave as detailed below: 
 

 

2.4 Sensor Mounting 

The sonar must be mounted with the transmitter (projector) pointing aft, so that the receiver is 
measuring in the quietest, least turbulent water for best SNR. Mount the sonar in-line with the keel 
or centerline of the survey platform and parallel to the water surface, ideally to within about 0.5°. 
 
It is best practice to feed the sonar cable through the mounting pole to protect against vibration or 
flotsam collision. Ensure connectors are always clean and dry, and ensure that pins are not bent. If 
there are any hazards that may expose cables to abrasion, use a chafing guard to protect it by 
adding rubber tape around the cable at the point of concern. 
 
 

⚠ 

CAUTION:  Cables Are Not Wet Mateable 

Only connect cables to connectors when dry. Use compressed air to ensure 
that they are clean and dry. 

 
 
Care should be taken when routing sensor cables so as not to damage the equipment. It is advised 
to keep bends in the cables to a minimum and to avoid kinks, twists or cable stretching. Avoid 
pinching the cables in windows, doors and other equipment. Cables should be secured to avoid 
excess movement or prevent wear on the cable sheath. Long cables should be kept away from 
power sources and separated from itself (not coiled tightly and placed in a corner) to avoid electrical 
interference. 
 
NORBIT sonars have been tested at a transit speed of 20 knots without damage to the system. If 
not performing a survey, it is best to transit with the sonar out of the water to protect the system from 
physical damage from flotsam. 

Indicator Pattern Description 

Sonar LED Steady Green 
Blinking Green (1Hz) 
Blinking Green (ISO 1Hz) 
Blinking Green (5Hz) 
Off 

Sonar Pinging 
Sonar Stand By 
Sonar Booting 
Sonar Over Current Failure 
Sonar Off 

PPS LED Blinking Orange (1Hz) 
Blinking Orange (5Hz) 
Steady Orange 
Off                                                 

Sync/Timing OK 
No Sync, NMEA Missing 
No Sync, PPS Missing 
No Sync, NMEA and PPS Missing 

Aux In/Out LED Off Not currently in use 

Power On/Off LED Steady Green 
Blinking Green (5Hz) 
Off 

Input Voltage OK 
Input Voltage <10v or >28V 
No Input Voltage 

ETH Blinking Green 
Off 

INS established valid Ethernet connection 
No INS Ethernet connection 

Msg Blinking Green 
Off 

INS receiving RTK corrections 
No RTK corrections 

SV Blinking Green 
Off 

INS detecting satellite vehicles 
No satellite vehicles detected 
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 Sonar Mounting Location 

Generally, the Sonar Reference Point should be clear of the lowest part of the hull to avoid reflections 
from the hull and water surface. A strong hull-reflection will reduce SNR for all beams.  Additional 
sonar draft may be required depending on the characteristics of the vessel hull which may create 
bubbles during vessel motion, especially as the sea state worsens. It is critical that the sound speed 
sensor on the NORBIT sonar has clean bubble-free water.  
 

 
 

 
 

 Acoustic Clearance Zones 

In shallow water conditions, when danger of collision is especially high, users may want to build a 
safety cage around the sonar. The following images indicate areas that must be kept clear. 
 

 
 
 

 
 
 
 
 
 
 
 
 
 

WINGHEAD WBMS 

2m 

Forward 

Generally, mount NORBIT sonar 0.7m below 
waterline, and certainly below the keel 

Placing all sensors on a common 
pole mount brings greatest ease 
and flexibility   

Primary antenna is 
closest to sonar 
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 WINGHEAD B41 & WINGHEAD i77h 

By default, the two bracket components are oriented vertically for pole mount installations. Secure 
the sonar using 4 M10 bolt screws, inserting the screws from the top. The screw length should be 
18-23mm longer than the thickness of the mounting flange. For long term mounting, use an 
anaerobic thread adhesive such as Loctite 242 Blue to prevent the screws from loosening. Do NOT 
use anything stronger than Loctite 242. 

 

 
 
The pole should have a minimum internal diameter of 5.8cm to allow the connector to pass through. 
Secure the cable in the groove at the center of the bracket, as indicated below. 
 
 

 
  

The bracket can be oriented in the horizontal direction for hull mount installations. In this 
configuration, up to 6 bolts can be used to secure the sonar. For more information on hull mounts, 
refer to section 2.4.7. 

 iWBMS, iWBMSh, iWBMSe & STX 

Use at least 4 bolts (2 forward and 2 aft) made of high-quality stainless steel to ensure of anti-
corrosion especially in saltwater environments. Use a lock washer and/or an anaerobic thread 
adhesive such as Loctite 242 Blue to prevent loosening of sonar during long deployments. 

 

 
 

iWBMS with standard 1.9°projector (Bracket PN 35021) 

Pole Flange 

Bracket Section 1
8
 -

 2
3
m

m
 

Cable groove 

Cable groove 
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The bolt hole pattern shown above is applicable for all integrated iWBMS systems. The sonar and 
IMU cables should never be connected or disconnected underwater. Ensure all connector pins and 
sockets are clean and dry. Always use the supplied connector caps on wet-end, cables and topside. 
Use a synthetic O-ring lubricant on connector O-rings that are in good condition. 

 
 

⚠ 

CAUTION:  Feed Cables Through Center of Bracket 

The mounting bracket requires that wet-end cables be run through the top 
center opening of the iWBMS bracket. If the mounting pole is a pipe 
(recommended), its minimum inner diameter should be 5.8cm. The iWBMSe 
requires the pole be centered over the single connector. 

 

 WBMS (Sonar Only) 

The bolts that secure the sonar to the pole/bracket should be 30-35mm longer than the thickness of 
the mounting bracket and made of high-quality stainless steel to prevent corrosion, especially in 
saltwater environments. Use a lock washer and/or an anaerobic thread adhesive such as Loctite 
242 Blue to prevent loosening of sonar during long deployments. It is also possible to permanently 
hull mount the sonar. For more information refer to section 2.4.7. 

 

 

 

 

 

 

 

 

 

⚠ 

CAUTION:  Electrically Isolate Sonar from Metal Boat 

If using a custom-built sonar mount, use a non-conductive plate to 
electrically isolate the sonar. This will help prevent corrosion. 

 
 
 
 
 
 
 
 
 
 
 
 

✓ ✗ 
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 GNSS Antennas 

Integrated NORBIT systems are supplied with 2 GNSS antennas, usually Trimble 540AP or Trimble 
382AP. They must have a clear view of the sky to the horizon so that every satellite may be 
continuously tracked without obstruction. The mounting locations should be free from vibration and 
rigid with respect to each other and the IMU. Note that the maximum recommended antenna cable 
length is 30m, as longer lengths cause signal degradation. 
 

 
 
The Primary Antenna (Antenna 1) should be nearest to the IMU so that offset measurement errors 
are minimized. The Secondary Antenna (Antenna 2) should be a fixed distance from Antenna 1. It 
is recommended that the antennas be at least 2m apart. The antennas should be positioned parallel 
to the water surface to within 2-3cm. 
 
While the antennas may be oriented in any direction horizontally, it is good practice to orient them 
to be parallel or perpendicular to the vessel centerline. 

 Hull Mounted Systems 

NORBIT sonars can be permanently hull-mounted to a vessel for operations that do not require the 
system to be portable. Examples of hull-mounted assemblies are shown below. The sonar pod must 
be carefully designed to prevent formation of bubbles and to allow water to flow over the SV sensor.  
 

   
 
To enquire about NORBIT’s complete hull-mounted design and installation service, please contact 
NORBIT Support. 
 

2.5 Time Synchronization (Non-Integrated Systems) 

Timing is crucial for synchronizing signals from the sonar, GNSS and IMU. Only the standalone 
NORBIT sonars (WINGHEAD B41 and WBMS) require PPS & NMEA ZDA hardware input. All 
integrated NORBIT systems receive timing from the internal GNSS card. The system can handle 
baud rates from 4800 to 115200 and will have no problem maintaining sync with other NMEA 
messages output on the same port as the ZDA+PPS. Ensure that the baud rate is fast enough to 
allow throughput of all strings. 
 
The PPS can be input in two ways: 

• To the BNC “PPS” connector on the SIU 

• To the Serial “GPS” DB9 connector on the SIU (pin 9 for pulse & pin 5 for ground) 

Trimble 540AP Antenna 
L1 Phase: 58mm from base 

  

Trimble 382AP Antenna 
L1 Phase: 66mm from base 
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The PPS signal can be either active low or active high. The SIU synchronizes to the falling edge of 
an active low signal, or the rising edge of an active high signal. The voltage on the PPS should not 
exceed 5V. 
 
For standalone models, the SIU should receive a PPS TTL input at 3.3V (5V tolerant). The SIU can 
autodetect a negative or positive PPS input and has ±15kV ESD protection, ±60V fault protection. 
 
Integrated GNSS/INS NORBIT systems can output a (positive or negative configurable) PPS TTL 
signal at 5V. However, it is NOT fault protected and is rated for a maximum absolute voltage of 6V. 
 
 

⚠ 
CAUTION:  Do Not Connect Active PPS to SIU for Integrated Systems 

The integrated versions of the SIU outputs PPS pulses. Attaching an active 
PPS cable to this port will damage internal electronics and void the warranty. 

 

 
 
The included DB9 timing cable should be used to interface a GNSS for timing. It splits the signal so 
that both the survey computer and SIU can be connected to the same GNSS port. 
 

 
 

Timing Cable Pinouts 

Connector A Connector B Connector C Description 

1 1 1 Not Connected 

2 2 2 Transmit Data (from GNSS) 

3 3 - Receive Data (to GNSS) e.g. for NTRIP 

4 - - Not Connected 

5 5 5 Ground 

6 - - Not Connected 

7 - - Not Connected 

8 - - Not Connected 

9 - 9 PPS (from GNSS) 

Active Low PPS 
 
 
 
 
 
 

Active High PPS 

+5V 
 
 
 
 

0V 
 
 
 
 
 
 

+5V 
 
 
 

0V 
 

Sync Time 

Up to 200ms 

PC SIU 
GPS            PPS 

Port 1         Port 2 Port 1            PPS 

PC SIU 
GPS             PPS 

ZDA 
PPS 

GGA 
GSV… 

SIU Timing Cable 

SIU Timing 
Cable 

ZDA 
GGA 
PPS 

ZDA 
GGA 

Coax 
Cable 

GNSS GNSS 

Method 1     Method 2 

A A 

B 
B C C 
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2.6 Dual Head Setup 

NORBIT sonars can be mounted in the standard dual-head brackets, sold separately. Alternatively, 
each sonar may be attached to a single-head bracket. For more details on dual head setup, refer to 
the Dual Head Quick Start at the end of this manual. 

 WINGHEAD 

One iSIU-WH (part no. 29060) and one SIU-WH (part. no. 29064) is required. Timing must be 
supplied (NMEA ZDA and 1PPS) from the iSIU-WH to the SIU-WH. In addition, a WINGHEAD 
Trigger cable (part no. 33249) is required to synchronize the topside units. 
 

 

 iWBMS & WBMS 

There are several ways to configure a dual head system, depending on what components are 
available. The simplest and recommended setup uses one SIU-I-NAV (Part No. 29028, revision 5 
or later) with both sonars connected to the same topside. It must be supplied with 24VDC, and a 
220W power brick is required. The standard power brick for single head systems (120W) is not 
sufficient. For older SIU-I-NAV revisions (revision 4 and earlier), the power supply unit must be 
upgraded. Timing requirements are handled internally and no additional cables are needed. 
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Alternatively, two SIU-I (stand-alone SIU, part no. 29024) may be used, or one SIU-I-NAV can be 
combined with one SIU-I. In each case, sonar timing (NMEA ZDA and 1PPS) must be supplied to 
both systems, and the topside units must be linked with a TTL sync cable via the Aux ports. For 
Alternative Setup 1, the PPS port on the SIU-I-NAV acts as PPS OUT, and NMEA ZDA can be 
output from the serial port if configured as such on the last page of the INS Setup Wizard. 

 
 
 
 
 
 
 
 
 
 

 
 

 
 

Alternative Setup 1 

 
Alternative Setup 2 

 

Aux In/Out Socket 

No. WBMS Function 

1 LAN TX+ 

2 LAN TX- 

3 LAN RX+ 

4 LAN RX- 

5 RS232 TX 

6 RS232 RX 

7 Trigger/GPIO 

8 RS232/Trig GND 

9 PWR GND 

10 PWR + 24VDC 

Sync Cable Connections 

Primary Secondary 

8-GND 8-GND 

5-Trig Out 6-Trig In 

6-Trig In 5-Trig Out 
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2.7 Decoupled IMU 

In some scenarios it may be necessary to decouple the IMU from the sonar and mount it elsewhere 
on the survey platform. Note, this only applies to the iWBMS series. 
 
To decouple the IMU from the WBMS, start by removing the 4 bolts at the back of the iWBMS 
bracket. This should be done with the iWBMS resting on a padded surface to reduce the risk of 
damage. Carefully separate the IMU from the sonar, taking care not to lose the dowel nuts located 
in the base plate of the IMU. NORBIT provides an optional plate for mounting the decoupled IMU in 
its NORBIT housing, with the connector facing towards the bow. Refer to Appendix E1. 
 
If the optional mounting plate is not used, the dowel nuts can be used. This requires that the IMU be 
secured to a mounting location that facilitates tightening the mounting screw from underneath. The 
screws should be M6 and of sufficient length to extend 23mm from the top of the mounting plate. 
 

 

⚠ 

NOTE:  Decoupled IMU Offset 

The IMU is 0.08m below the top of the fairing. In the INS Setup Wizard, 
apply a custom Sonar Ref. Point to IMU Ref. Point offset. 

 

 
Two cables are typically required if operating the system in a decoupled configuration: the standard 
split cable for the IMU (PN 33129), and a WBMS cable (PN 33029) for the sonar. In this case the 
sonar must be interfaced to the Aux port on the SIU. 
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 Offsets & Reference Points 

The Sonar Reference Point is where all sonar (and navigation data, for integrated systems) is valid. 
Thus, all sensors in the acquisition and processing software must have the same offset to this 
location. It is located at the center of the projector in the fore-aft direction, and at the center of the 
cylindrical receiver array in the port-starboard and vertical directions. 
 
The IMU Reference Point is shown for reference, but generally the user need not concern 
themselves with this. The Top Center of Bracket is merely a convenient point from which to 
measure the primary GNSS antenna offset for integrated systems. For dual head setups, it is more 
convenient and practical to use the Top Center of Dual Head Bracket as the Measure Point. 
 
When the sonar and IMU are rotated, the offsets and angles must be adjusted accordingly. Consult 
the technical note TN-190018 for details, and contact NORBIT Support if you require this document. 

3.1 WINGHEAD Reference Points 

Refer to section 3.2 and 3.3 for all relevant offsets and mounting angles for each WINGHEAD 
configuration. For single head configurations, the offsets and IMU mounting angles are applied 
automatically in the INS Setup Wizard based on the detected sonar model. 

 

Sonar Kit Side View Front View 

WINGHEAD B41 

  

WINGHEAD i77h 

 
 

3.2 WINGHEAD Offsets & IMU Angles 

 
 
 

3.3 WINGHEAD Dual Head Offsets & Mounting Angles (IMU +10° on Port) 

 
 
 
 
 
 

Sonar Kit Name in GUI 
Sonar Ref. Point to 

IMU Ref. Point 
IMU Mounting 

Angles 

Sonar Ref. Point to 
Top Center of Bracket 

WINGHEAD i77h 
(Applanix OceanMaster) 

WINGHEAD i77h 
+Fwd: 0.092 m 
+Stbd: 0.000 m 
+Down: 0.040 m 

X: 0⁰ 
Y: 90⁰ 
Z: 0⁰ 

+Fwd: 0.029 m 
+Stbd: 0.000 m 

+Down: -0.027 m 

Sonar Kit 
Sonar Ref. Point 

to IMU Ref. 
Point 

IMU Mounting 
Angles (IMU 

mounted on Port) 

Sonar Ref. Point to 
Measure Point (Top Center 

of Dual Head Bracket) 

Sonar Ref. Point 
(Primary) to Sonar Ref. 

Point (Secondary) 

WINGHEAD i77h 
(Applanix OceanMaster) 

+Fwd: 0.092 m 
+Stbd: -0.007 m 
+Down: 0.039 m 

X: 89⁰ 
Y: 80⁰ 
Z: 89⁰ 

+Fwd: 0.029 m 
+Stbd: 0.226 m 

+Down: -0.064 m 

+Fwd: 0.000 m 
+Stbd: 0.452 m 
+Down: 0.000 m 

2
7
 

29 

4
0

 
2

7
 

92 

29 
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3.4 WBMS Reference Points 

The drawings below are only intended as a visual indication of the reference points, as the 
offsets differ depending on the operating frequency, bracket, projector and IMU type. Refer 
to section 3.5 for all relevant offsets and mounting angles for each WBMS configuration. 
 
For single head configurations, the offsets and IMU mounting angles are applied automatically in 
the INS Setup Wizard based on the detected sonar model. 
 

Sonar Kit and Bracket Side View Front View 

12004 & 12007 
iWBMS, iWBMSh 

Projector: Standard 1.9° 
Bracket PN: 35021 

  

12004 & 12007 
iWBMS, iWBMSh 

Projector: Narrow 0.9° 
Bracket PN: 35021 

  

12006 
iWBMSe 

Projector: Standard 1.9° 
Bracket PN: 35047 

 
 

 
 
 
 
 
 
 
 
 

198-256 

7
0
 

7
8

-7
9
 

122-170 
7

9
 

158-172 

234-255 

2
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117-188 

53-103 
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3.5 WBMS Offsets & Mounting Angles 

Sonar Kit Name in GUI 

Sonar and 
Bracket PN  

(* values that may 
be ignored) 

IMU PN 
Sonar Ref. Point 
to IMU Ref. Point 

IMU 
Mounting 

Angles 

Sonar Ref. Point 
to Top Center of 

Bracket 

400KHZ SONARS WITH NARROW TRANSMIT (0.9⁰) OPTION 

12007 iWBMSh STX, 400kHz 
(Applanix OceanMaster) 

iSTX-0.9°x0.9° 
24016-*-*B***B 
Bracket: 35021 

24015 
(Type 64) 

+Fwd: 0.234 m 
+Stbd: 0.000 m 
+Down: 0.079 m 

X: 90⁰ 
Y: 0⁰ 
Z: -90⁰ +Fwd: 0.158 m 

+Stbd: 0.000 m 
+Down: -0.070 m 24006-9X 

(Type 89) 

+Fwd: 0.242 m 
+Stbd: 0.000 m 
+Down: 0.079 m 

X: 0⁰ 
Y: 90⁰ 
Z: 0⁰ 

12007 iWBMSh 400kHz 
(Applanix OceanMaster) 

iWBMS-0.9°x0.9° 
24003-*-*B**** 
Bracket: 35021 

24015 
(Type 64) 

+Fwd: 0.248 m 
+Stbd: 0.000 m 
+Down: 0.079 m 

X: 90⁰ 
Y: 0⁰ 
Z: -90⁰ +Fwd: 0.172 m 

+Stbd: 0.000 m 
+Down: -0.070 m 24006-9X 

(Type 89) 

+Fwd: 0.255 m 
+Stbd: 0.000 m 
+Down: 0.079 m 

X: 0⁰ 
Y: 90⁰ 
Z: 0⁰ 

12004 iWBMS STX, 400kHz 
(Applanix WaveMaster) 

iSTX-0.9°x0.9° 
24016-*-*B***B 
Bracket: 35021 

24006-4X 
(Type 42) 

+Fwd: 0.234 m 
+Stbd: 0.000 m 
+Down: 0.079 m 

X: 90⁰ 
Y: 0⁰ 
Z: -90⁰ +Fwd: 0.158 m 

+Stbd: 0.000 m 
+Down: -0.070 m 24006-8X 

(Type 82) 

+Fwd: 0.242 m 
+Stbd: 0.000 m 
+Down: 0.079 m 

X: 0⁰ 
Y: -90⁰ 
Z: 0⁰ 

12004 iWBMS, 400kHz 
(Applanix WaveMaster) 

iWBMS-0.9°x0.9° 
24003-*-*B**** 
Bracket: 35021 

24006-4X 
(Type 42) 

+Fwd: 0.248 m 
+Stbd: 0.000 m 
+Down: 0.079 m 

X: 90⁰ 
Y: 0⁰ 
Z: -90⁰ +Fwd: 0.172 m 

+Stbd: 0.000 m 
+Down: -0.070 m 24006-8X 

(Type 82) 

+Fwd: 0.255 m 
+Stbd: 0.000 m 
+Down: 0.079 m 

X: 0⁰ 
Y: -90⁰ 
Z: 0⁰ 

12006 iWBMSe, 400kHz 
(Applanix SurfMaster) 

iWBMSe-0.9°x0.9° 
24018-*-*B**** 
Bracket: 35047 

24013 
(Type 69) 

+Fwd: 0.103 m 
+Stbd: 0.000 m 
+Down: 0.095 m 

X: 0⁰ 
Y: 0⁰ 
Z: 180⁰ 

+Fwd: 0.167 m 
+Stbd: 0.000 m 

+Down: -0.023 m 

400KHZ SONARS WITH STANDARD TRANSMIT (1.9⁰) OPTION 

12007 iWBMSh, 400kHz 
(Applanix OceanMaster) 

iWBMS-0.9°x1.9° 
24003-*-*C**** 
Bracket: 35021 

24015 
(Type 64) 

+Fwd: 0.198 m 
+Stbd: 0.000 m 
+Down: 0.079 m 

X: 90⁰ 
Y: 0⁰ 
Z: -90⁰ +Fwd: 0.122 m 

+Stbd: 0.000 m 
+Down: -0.070 m 24006-9X 

(Type 89) 

+Fwd: 0.206 m 
+Stbd: 0.000 m 
+Down: 0.079 m 

X: 0⁰ 
Y: 90⁰ 
Z: 0⁰ 

12004 iWBMS, 400kHz 
(Applanix WaveMaster) 

iWBMS-0.9°x1.9° 
24003-*-*C**** 
24003-1b (old) 
Bracket: 35021 

24006-4X 
(Type 42) 

+Fwd: 0.198 m 
+Stbd: 0.000 m 
+Down: 0.079 m 

X: 90⁰ 
Y: 0⁰ 
Z: -90⁰ +Fwd: 0.122 m 

+Stbd: 0.000 m 
+Down: -0.070 m 24006-8X 

(Type 82) 

+Fwd: 0.206 m 
+Stbd: 0.000 m 
+Down: 0.079 m 

X: 0⁰ 
Y: -90⁰ 
Z: 0⁰ 

12006 iWBMSe, 400kHz 
(Applanix SurfMaster) 

iWBMSe-0.9°x1.9° 
24018-*-*C**** 
Bracket: 35047 

24013 
(Type 69) 

+Fwd: 0.053 m 
+Stbd: 0.000 m 
+Down: 0.096 m 

X: 0⁰ 
Y: 0⁰ 
Z: 180⁰ 

+Fwd: 0.117 m 
+Stbd: 0.000 m 

+Down: -0.023 m 

200KHZ LONG RANGE SONARS 

12007 iWBMSh 200kHz 
(Applanix OceanMaster) 

iWBMS-1.9x1.9° 
24007-*-*C**** 
Bracket: 35021 

24015 
(Type 64) 

+Fwd: 0.241 m 
+Stbd: 0.000 m 
+Down: 0.079 m 

X: 90⁰ 
Y: 0⁰ 
Z: -90⁰ +Fwd: 0.170 m 

+Stbd: 0.000 m 
+Down: -0.070 m 24006-9X 

(Type 89) 

+Fwd: 0.256 m 
+Stbd: 0.000 m 
+Down: 0.079 m 

X: 0⁰ 
Y: 90⁰ 
Z: 0⁰ 

12004 iWBMS, 200kHz 
(Applanix WaveMaster) 

iWBMS-1.9°x1.9 
24007-*-*C**** 
Bracket: 35021 

24006-4X 
(Type 42) 

+Fwd: 0.241 m 
+Stbd: 0.000 m 
+Down: 0.078 m 

X: 90⁰ 
Y: 0⁰ 
Z: -90⁰ +Fwd: 0.170 m 

+Stbd: 0.000 m 
+Down: -0.070 m 24006-8X 

(Type 82) 

+Fwd: 0.256 m 
+Stbd: 0.000 m 
+Down: 0.079 m 

X: 0⁰ 
Y: -90⁰ 
Z: 0⁰ 

12006 iWBMSe, 200kHz 
(Applanix SurfMaster) 

iWBMSe-1.9°x1.9° 
24022-*-*C**** 
Bracket: 35047 

24013 
(Type 69) 

+Fwd: 0.100 m 
+Stbd: 0.000 m 
+Down: 0.095 m 

X: 0⁰ 
Y: 0⁰ 
Z: 180⁰ 

+Fwd: 0.188 m 
+Stbd: 0.000 m 

+Down: -0.023 m 
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3.6 WBMS Dual Head Offsets & Mounting Angles (IMU +37.5° on Port) 

 
 
 
 
 
 
 

 
The IMU type can be found in the NORBIT GUI under INS Tools > System Status > POS Version. 
For custom arrangements (e.g. different rotation angles, or IMU installed on starboard side) please 
consult the technical note TN-190018. Contact NORBIT Support if you require this document. 

 

 System Operation 

The sonar system is setup and controlled using the NORBIT GUI. The GUI can be monitored by 
multiple computers, but only one GUI can control the sonar. The GUI may also be controlled in 
headless/passive mode, refer to Section 4.1.2 for details. 

4.1 NORBIT GUI Installation 

The GUI executable file installs the NORBIT Graphical User Interface (GUI) and copies firmware to 
the PC. NORBIT recommends disabling Windows Firewall, or adding a port exception, to allow 
communication with the integrated INS. See the Troubleshooting section for more details. 

 PC System Requirements 

Since all sonar data processing happens inside the sonar head, the GUI can be run on the same 
computer as the acquisition software. The minimum system requirements are shown below. Note 
that these may change depending on the acquisition software used. 
 

 

*The GUI may work on Windows 7 if Microsoft Visual C++ 2015 (Redistributable Update 3 RC) is installed. The installation 
file is provided on the USB device, and can also be downloaded from Microsoft. Microsoft has stopped mainstream support 
of Windows 7 as of January 13, 2015. Starting from v10.3, NORBIT does not test software for compatibility with Windows 7. 

Sonar and IMU Type 
Sonar Ref. Point 

to IMU Ref. 
Point 

IMU Mounting 
Angles (IMU 

mounted on Port) 

Sonar Ref. Point to 
Measure Point (Top Center 

of Dual Head Bracket) 

Sonar Ref. Point 
(Primary) to Sonar Ref. 

Point (Secondary) 

iWBMSh (IMU Type 42) 
iWBMS (IMU Type 64) 

+Fwd: 0.248 m 
+Stbd: -0.048 m 
+Down: 0.063 m 

X: 90⁰ 
Y: 37.5⁰ 
Z: -90⁰ 

+Fwd: 0.172 m 
+Stbd: 0.215 m 

+Down: -0.210 m 

+Fwd: 0.000 m 
+Stbd: 0.430 m 
+Down: 0.000 m 

iWBMSh (IMU Type 89) 
+Fwd: 0.255 m 

+Stbd: -0.048 m 
+Down: 0.063 m 

X: 90⁰ 
Y: 52.5⁰ 
Z: 90⁰ 

+Fwd: 0.172 m 
+Stbd: 0.215 m 

+Down: -0.210 m 

+Fwd: 0.000 m 
+Stbd: 0.430 m 
+Down: 0.000 m 

iWBMS (IMU Type 82) 
+Fwd: 0.255 m 

+Stbd: -0.048 m 
+Down: 0.063 m 

X: 90⁰ 
Y: -37.5⁰ 
Z: -90⁰ 

+Fwd: 0.172 m 
+Stbd: 0.215 m 

+Down: -0.210 m 

+Fwd: 0.000 m 
+Stbd: 0.430 m 
+Down: 0.000 m 

iWBMSe (IMU Type 69) 
+Fwd: 0.103 m 

+Stbd: -0.058 m 
+Down: 0.075 m 

X: -37.5⁰ 
Y: 0⁰ 
Z: 180⁰ 

+Fwd: 0.167 m 
+Stbd: 0.186 m 

+Down: -0.173 m 

+Fwd: 0.000 m 
+Stbd: 0.372 m 
+Down: 0.000 m 

Hardware Requirements 

Operating 
System 

Windows 10 Pro (Recommended) / Windows 8.1 (Fully Updated) / Windows 7 or Vista 
(Unsupported) * / Windows XP (Untested) 

Processor 2GHz or more 

Memory 4GB or more 

Display 
Resolution 

1400x900 or higher 
Lower resolution can be used but it is not optimal. It will not impair data acquisition. 

Graphics Card Integrated graphics are sufficient for running the GUI. A dedicated graphics card is 
required for running data acquisition or processing software. 

Network 
Speed 

1Gbit Ethernet (WINGHEAD Series) 
100Mbit Ethernet (WBMS Series) 

Storage GUI operation only: <1GB; Full system with logging: >100GB 

https://www.microsoft.com/en-us/download/details.aspx?id=52685
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 Operation Without GUI (Direct Connection), Headless Mode & Passive Mode 

Some setups, such as those on AUV/ROVs, may require operation without the NORBIT GUI. Users 
can interface with the sonar on a script level, providing direct commands to the sonar. 
 
In addition, the GUI can be operated in headless and passive mode. Please note that both modes 
increase bandwidth consumption. These modes are not intended to be used where several 
observers are required, as it substantially increases sonar bandwidth and may cause data loss. 
 
Passive mode is a special operating mode of the GUI where user has no interaction with the sonar. 
The data flows through the GUI and is visualized as normal, but the user cannot change any sonar 
settings. The data is also output as an s7k stream, so the GUI acts as a proxy server. In this mode, 
the user can still change some GUI related options in a limited way. This mode is mostly used for 
data visualization in real time, without the risk that the user will change any sonar settings. 
 
Headless mode is a further simplification of passive mode, where the data flow is the same, however 
no graphical user interface is displayed for visualization, and instead only a simple console is 
displayed. In this case the software acts as a proxy server with no interaction. 
 
For further information on these modes, please contact NORBIT Support. 

4.2 Network Configuration  

NORBIT sonars connect to the acquisition computer via standard Ethernet protocol. To 
communicate with the SIU, the computer network adaptor must be configured to the same subnet. 
 
To configure the computer IP address, navigate to the 
network adaptor properties and change the TCP/IPv4 
settings. The last 3 digits of the IP address must not 
conflict with the address of the sonar or integrated INS. 
 
The INS systems come pre-configured with an IP address 
of 192.168.53.100. The IP address of the sonar is always 192.168.53.XX, where XX represents the 
last two digits of the sonar serial number. A subnet mask of 255.255.255.0 should be used. NORBIT 
recommends setting the IP address of the acquisition computer to 192.168.53.150. 

 
In rare circumstances, some users may wish to change the IP address of the sonar. See section 5.4 
for details. It is recommended to NOT change the sonar IP address unless absolutely necessary. 
 

 

⚠ 

CAUTION:  Do NOT Connect Multiple Network Cards to Same Subnet 

When connecting multiple network cards, do NOT have a Wi-Fi adapter 
connected to the same subnet as the wired network. This causes duplication 
of navigation data and introduces artefacts to the sonar data. 

 
 

⚠ 

CAUTION:  Changing IP Address of INS Disables GUI Functionality 

Changing the IP address of the INS from the factory configured IP address 
(192.168.53.100) will disable INS capabilities within the GUI. 
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 DHCP Connection 

Unless otherwise required, make sure that DCHP servers are not running on the same network as 
the sonar. This causes an automatic IP address assignment during bootup. If this occurs, and a 
DHCP network is not desired, power off the SIU, assign a static IP address, and power cycle. 

4.3 Connect to Sonar 

Upon launching the GUI, the Connection Dialog is displayed. If a sonar is active on the network, a 
green light is displayed. A red light indicates that the sonar is offline. 
 
Select the sonar to highlight the row and click Connect. After the first successful connection is 
established, all subsequent connections to the sonar are automatic. 
 
To connect to two sonars in dual head mode, specify which sonar is primary, highlight both rows, 
and click Connect. For more information, refer to the Dual Head Quick Start Guide. 

 
Once connected, an automatic check is performed to ensure that the firmware is compatible. A 
warning is displayed on the Connection State tab if the firmware is incompatible. To correct this, 
click Perform Update and follow the instructions. 

 

    
 
Please note that it is unsafe to turn off power to the sonar once the upgrade process has 
started, and that doing so risks corrupting the system configuration. Operating a firmware and 
GUI with mismatching versions may cause unstable operation. 
 
When the upgrade is complete, power cycle the sonar. NORBIT recommends selecting Set Sonar 
Factory Defaults after each installation or upgrade. 

4.4 INS Tools for WINGHEAD i77h, iWBMS, iWBMSh & iWBMSe 

The NORBIT GUI contains integrated INS functionality, allowing the sonar 
and INS to be setup and controlled from the same user interface. The INS 
Tools are found at the bottom of the settings menu, and the INS Setup 
Wizard allows users to configure offsets and GNSS corrections. 
 
For users with standalone WINGHEAD or WBMS systems. most settings 
under INS Tools are greyed out. Users with integrated systems must have 
INS firmware v9.03 or later. To request an upgrade, contact NORBIT Support 
with the serial number, and a screenshot of the System Status dialog. 
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 INS Setup Wizard 

 Factory Settings 

NORBIT advises that, prior to each new installation, the factory default settings are restored. Open 
the INS Setup Wizard and select Factory. Note, this only resets the INS configuration and has no 
impact on the sonar configuration or GUI display preferences. 
 
 

⚠ 

CAUTION:  Incorrect Offsets When Changing Computers 

Offsets are stored on the computer from which the setup was performed. If 
the computer is changed, the displayed Measure Point to Antenna Bottom 
offset is from the Sonar Reference Point to primary antenna phase center. 
This does not affect operation unless the configuration is re-saved. NORBIT 
recommends reviewing all inputs prior to each survey. 

 

 IMU Offset & Mounting Angles 

The first page of the setup wizard shows the sonar 
model in the System selection and the relevant 
offsets and mounting angles. The model is 
automatically detected, and for most users there is 
nothing to change here. 
 
If custom offsets or mounting angles are required, 
select the Custom system option. This is only 
required for advanced installations where the IMU is 
physically decoupled from the sonar (see section 
2.7) and installed at a separate location. Note that 
WINGHEAD IMUs cannot be decoupled. 

 
 

 

⚠ 

NOTE:  Dual Head Tilted Offsets 

In dual head configurations, the IMU rotations and offsets must be modified if 
the sonars are tilted. For further information, refer to the NORBIT tilted sonar 
technical note (document TN-190018) and the NORBIT Dual Head Quick 
Start. If you do not have this document, please contact NORBIT Support. 

 

 Antenna Offsets 

Select the Primary Antenna model, which in most cases will be Trimble 540AP, to ensure that the 
correct phase center offset is applied. 
 
Select the Measure Point to define a convenient reference point from which to measure the primary 
antenna offset. Top Center of Bracket should normally be selected. A Custom point may also be 
defined. For dual head setups, it is more convenient and practical to define a custom point and use 
the top center of the dual head bracket. 
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Carefully measure the distance from Measure Point to Antenna Bottom and enter the correct 
values, bearing in mind the sign convention (positive 
down). 

 
Users can specify the Heading Threshold for the 
heading alignment procedure which follows later. The 
Default Value (0.5⁰) is suitable in most cases. It may be 
necessary to change the threshold, e.g. if operating a 
large vessel and aggressive maneuvering is not 
possible. If the heading alignment does not start within 
30 minutes, select Custom and increase the threshold in 
0.5⁰ increments until the alignment starts successfully. 
Every time a heading alignment is performed, a patch 
test should be performed afterwards. 
 
For Heading Alignment method, select Heading 
Alignment Wizard to populate the fields in Primary to 
Secondary Antenna Baseline Vector with zeros 
initially. Correct values are displayed after the alignment 
is complete (described in section 4.4.2). If the antenna 
baseline vector is already known, i.e. if it was measured 
using land survey techniques, the results can be entered 
by selecting Custom. 

 
Selecting Plan View or Profile View displays a diagram 
showing the antenna positions with respect to the Sonar 
Reference Point. This can be used for a visual check of 
the system layout/offsets. 
 
 

⚠ 

NOTE:  NORBIT GUI and POSView / POSPac Offsets Are Different 

Offsets displayed in POSView/POSPac for Ref. to Primary GNSS Lever 
Arm are different from those entered in the NORBIT GUI. GUI offsets are 
referenced from Measure Point (typically Top Center of Bracket), whereas 
POSView/POSPac offsets are referenced from Sonar Ref. Point. 

 

 Center of Rotation Offset 

The vessel Center of Rotation (CoR) offset should be 
entered relative to the Measure Point. Note that the 
center of rotation is more of an area rather than a well-
defined point on the vessel, therefore an approximation 
will suffice. Select Use CoR Offset and enter the 
measured values under Measure Point to Center of 
Rotation (CoR). 
 
The CoR, for most commercial vessels, is documented in 
the vessel design plans. For other vessels, it must be 
estimated. The location can be hard to determine, as it 
may change over time depending on fuel stowage and 
distribution of personnel body weight. Generally, choose a location that is about 3/4 distance from 
bow to stern, centered on the keel, and located at approximately water level. 
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 Integrated DGNSS 

The Integrated GNSS settings are used to specify the 
desired satellite GNSS correction service. Satellite Based 
Augmentation Service (SBAS) may be configured here. 
This is a correction source that is regional and free. 
 
Alternatively, Marinestar, a paid subscription service 
providing decimeter accuracy, may be configured. Refer 
to section 4.4.5 for details on activating a subscription. 

 RTK/Aux GNSS Input & NTRIP Client 

RTK corrections may be transmitted to the vessel from a 
land base station (via radio) and interfaced to the system 
via the serial COM port on the SIU. The radio on the 
vessel must therefore have a serial output, containing 
only the correction message. The incoming radio baud 
rate must match the selection in the setup wizard. 
 
Select the correct RTK Input Type (CMR, CMR+, CMRx, 
RTCM, etc.) as well as the input Line, either Serial or 
Modem. Please note that if an input type other than None 
is selected, the INS only uses GPS satellites, so it will 
likely result in fewer satellite vehicles being detected. 
Selecting None enables the INS to use additional 
satellites from other constellations such as GLONASS. 
 
Select the desired NMEA output messages. If using a 
radio link to receive corrections, you may need to set this 
output to Off to avoid issues related to decoding the 
correction message from the radio’s output. 
 
When an external GNSS system is used, select Aux. 
GNSS Input. Then enter the offset to the auxiliary 
antenna phase center. It is important to note that this 
offset should be measured from the Sonar Reference 
Point (see section 3) to the phase center of the auxiliary 
antenna. When the auxiliary system is connected, the INS 
compares its own solution against the quality of the 
auxiliary solution and automatically selects the best. The 
auxiliary input must include NMEA GGA as a minimum, 
and optionally GSV, GSA and GST. The update rate must 
not exceed 1Hz. 

 
To enable RTK corrections via NTRIP, select Ethernet as 
the RTK/DGNSS Input. Select NTRIP Client and enter 
the login details. Select Fetch Sources and select the 
source from the dropdown menu. Click Connect. 
 
Click Finish to complete the setup wizard. If Heading Alignment Wizard was selected in section 
4.4.1.3, finishing the setup wizard automatically starts the alignment wizard. If performing a heading 
alignment calibration is not possible at this time, you may select Cancel, with no loss of input values, 
and perform the calibration later. 

https://www.fugro.com/our-services/marine-asset-integrity/satellite-positioning/marinestar
https://www.fugro.com/our-services/marine-asset-integrity/satellite-positioning/marinestar
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 Heading Alignment Wizard 

A heading alignment must be performed when the NORBIT sonar is first installed, or when one of 
the INS sensors (IMU or GNSS antennas) is moved. The heading alignment determines the vector 
offset from primary antenna to secondary antenna, and in doing so ensures proper alignment of the 
IMU with the GNSS antenna pair. If a heading alignment was not performed at the end of the INS 
Setup Wizard, select INS Tools > Alignment Wizard. 
 

Step 1. Press Start to begin the calibration. The best 
results are achieved using RTK GNSS, with a 
clear sky view, away from tall structures that 
impede GNSS performance. The installation 
must be completely rigid and free from vibration. 
The primary antenna offset must be accurately 
measured and applied during the INS setup 
stage described in the preceding section. 

 
Step 2. Follow the recommended maneuvers during the 

pre-alignment stage and observe the display as 
the Heading Error RMS decreases from its initial 
value of 55°. Once the value drops below the 

defined threshold (Target Error) and stabilizes, 
the heading alignment begins. Continue to 
maneuver the vessel until this occurs. 
 

Step 3. Follow the instructions and continue to perform 
figure-of-eight maneuvers while the heading 
alignment is in progress. The overall time to 
complete the calibration depends on the size of 
the vessel and the speed at which the maneuvers 
are performed, as well as positioning quality. 

 
The computed results are unique to each 
installation. If the primary to secondary antenna 
baseline was manually measured beforehand, 
the calculated results should be similar. Select 
Commit to save the results. NORBIT 
recommends performing a patch test after the 
heading alignment. 

 Sky Plot 

The Sky Plot displays currently tracked satellites on the primary and secondary GNSS antennas. 
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 System Status 

The System Status window displays the status of the INS and reports any fault conditions that may 
occur during operation. Check this display if the Faults indicator on the GUI status bar appears red. 
Note that some items may display a red indicator intermittently during initialization and operation. 

 

 
 
Version information is displayed at the bottom. It displays all INS related hardware, software and 
firmware versions. Additionally, the Marinestar Status and subscription expiry date is shown. 

 Marinestar Subscription 

Follow these steps to activate a Marinestar (paid) subscription for decimeter-level GNSS corrections: 
 

Step 1. Select INS Tools > System Status and obtain the OMNSN number: 

 

Step 2. Go to http://www.fugroMarinestar.com/Order_form and request a subscription. In your request, you 
must supply the OMNSN number from the previous step. 

Step 3. Arrange a time with Fugro to activate the subscription, as the system must be powered on and 
tracking satellites when the activation code is transmitted. Be sure to consider time zone 
differences when organizing the activation time. 

Step 4. Enable Marinestar in the INS Setup Wizard, as described in section 4.4.1.5. In most cases you 
can leave the selection on Auto, however you may be advised to set a specific mode and 
frequency by Fugro, in which case select the Custom option. 

Step 5. Advise Fugro when the system is ready, and wait for the activation code to be sent. It may take 30-
45 minutes after the code is sent for the subscription to activate. 

Step 6. Confirm that the subscription is valid by observing the System Status window. You should expect 
to see the status updates as well as an updated expiration date. The INS status displays Pri. 
Marinestar… when the mouse is hovered over the INS Status indicator. 

http://www.fugromarinestar.com/Order_form
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 TSS1 

For standalone (non-integrated) NORBIT sonars, a TSS1 
message can be interfaced from an external motion sensor for 
roll stabilization. The TSS1 message should be interfaced to the 
computer via a COM port. Select Use TSS1 and select the COM 
port and Baud Rate. Click OK. The baud rate must match the 
output from the motion sensor. 

4.5 Main NORBIT GUI Display 

The sonar wedge shows a single ping of data from a thin slice of the water column. The wedge 
comprises 256, 512, or 1024 overlapping beams, which each contains a depth sounding. 
 

 
 
The sonar wedge is used to assess data quality and swath coverage. Currently applied settings and 
statistics are summarized and displayed right of the sonar settings, and left of the sonar wedge, e.g. 
frequency, sound speed, date and time, and ping number. The software and firmware versions are 
displayed at the top right corner. 

 
Each detection has an associated quality flag, 
which may be utilized by filters in post-processing 
software (HYPACK, Qimera, etc.). Multi detections 
are flagged as such when the Multidetect option is 
enabled (see section 4.6.4 for details). 

 
When two sonars are connected in dual head 
mode, two swaths are displayed. Each swath is 
labelled primary and secondary. For more information on dual head operation, refer to the Dual Head 
Quick Start Guide. 

Quality Description Flag 

 Bad Low SNR, low collinearity 0 

 Flyer High SNR, low collinearity 1 

 Low SNR Low SNR, high collinearity 2 

 Good High SNR, high collinearity 3 

 Multidetect Additional detections 4 
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 Upper GUI Status Indicators 

 
 
The Sonar indicators shows the streaming status of various data types as requested by the 
acquisition software. If the SS, SN or WC indicators are red, it indicates that the signal is saturated. 
Adjust the TVG settings under Backscatter Controls, as described in section 4.6.2. 
 
The INS indicators relate to the function and health of the 
integrated INS. Mouseover the indicators to display additional 
information such as current position, attitude and accuracy. 
 
The Logging indicator shows when raw INS data is recording. 
The GUI automatically logs INS data when the GUI is 
launched. This can be used for POSPac processing or for 
applying True Heave data. The log folder path is displayed by 
hovering over the indicator, and the path may be changed by 
selecting Advanced > Options > Paths.   

 
The Status indicator provides the current solution status (FIXED RTK, Pri. DGNSS, etc.) as well as 
the status of the current corrector stream. 
 

INS Status Navigator Description 

DR (Dead 
Reckoning) 

No GNSS input is available; navigation is using only the IMU data 

RTCM DGNSS Tightly coupled using raw observables plus corrections (RTCM 1 or 9) 

CODE DGNSS Tightly coupled using raw observables plus corrections (RTCM 18 and 19, CMR, CMR+) 

FLOAT RTK Tightly coupled using raw observables plus corrections (RTCM 18 and 19, CMR, CMR+) 

FIXED RTK Same as Float RTK but better accuracy 

Pri. C/A Closely coupled using primary GNSS position data in C/A mode 

Pri. DGNSS Closely coupled using primary GNSS position data in DGNSS mode 

Pri. P Code Closely coupled using primary GNSS position data in P-CODE mode 

Pri. RTK Closely coupled using primary GNSS position data in RTK mode 

Aux. DGNSS Loosely coupled using auxiliary GNSS position data in DGNSS mode 

Aux. P Code Loosely coupled using auxiliary GNSS position data in P-CODE mode 

Aux. Float RTK Loosely coupled using auxiliary GNSS position data in Float RTK mode 

Aux. WL RTK Loosely coupled using auxiliary GNSS position data in Wide Lane RTK mode 

Aux. NL RTK Loosely coupled using auxiliary GNSS position data in Narrow Lane RTK mode 

 
Currently, only the primary antenna tracks all GNSS constellations and SBAS satellites, therefore 
the primary GNSS antenna shows more satellites than the secondary antenna. 
 
 
 
 
 
 
 

Indicator Description 

Bathy Bathymetric detections 

SS Side Scan 

WC Water Column  

SN Snippets 

Roll Stab Roll Stabilization Status 
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 Lower GUI Viewer Bar 

 
 

By default, the sonar starts pinging once connected to the GUI. The Play  /Stop  button is 
used to start/stop pinging. Pinging should be stopped when the GUI is running with the sonar out of 
water, to prevent electronics from overheating. 
 
Users may also set the Side Scan Length and adjust display 
Brightness. The Brightness control bar only adjusts the wedge 
intensity displayed on the GUI; it does not affect the raw data 
signal. This can be used to effectively increase the illumination of 
received acoustic data. Applying too much brightness will saturate 
the image of the more reflective areas of the acoustic display, while 
applying too little results in a very dark image.  
 
The Zoom tool opens an adjustable pop-up window on the sonar 
wedge. The window can be dragged to any part of the wedge to 
magnify any segment of the swath. 

 

Displays a time trace for each beam separately when the water column is active. Right clicking 
allows the user to zoom in, while left clicking resets the zoom. Channels can be selected using 
the arrows at the bottom. A graphical selection appears on the wedge. 

 
Hide/unhides the sonar settings menu. The user still has control of the gates, and therefore 
the sonar range, by clicking/dragging the gates interactively on the wedge. 
 

Selecting  activates raw data recording. Recorded data can be replayed at any time (even during 
real time sonar operation and recording), as described in section 4.6.5.3. The GUI recording files 
are saved by default in: C:\Users\user\NORBIT\WBMS\. Each recording session generates a folder 
with the naming convention YYYY-MM-DD-HH_MM_SS. 

 Optimizing Backscatter Display 

Tuning the display Brightness and Gamma Correction (in Options) does not have any impact on 
the raw data signal and is only used to adjust the display. However, TVG settings impact data output. 
See section 4.6.2 for details. 
 
To optimize backscatter images visually:  

1. Adjust Brightness on the display control bar 
2. Under Backscatter Controls, ensure that Apply TVG is selected 
3. Adjust the settings for Static Gain, Spreading and Absorption until the side scan image 

appears unsaturated, and ensure that the SS/SN/WC indicators are green. 
 
These settings are dependent on current environmental conditions (water sediment content, salinity, 
temperature, etc.) and may have to be adjusted as the survey progresses. Ensure that the SS and 
SN indicators remain green (unsaturated) as saturated soundings will not be salvageable. 
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4.6 Sonar Settings Menus 

 View  

Most sonar control features can be found in the View menu. The 
user may specify Gate Mode, the Upper and Lower Gates, Swath 
angle and swath pointing Direction. Sonar range is a function of 
the Lower Gate, angular Swath width and swath pointing 
Direction. These parameters affect the total distance bottom 
detections can be from the sonar, and the ping rate is then 
determined by factoring in the speed of sound in water.  

 

Function Description 

Gate Mode 

Allows for selection of manual gates by upper and lower depth (Depth mode), by upper and 
lower range (Range mode) or by upper depth and lower range (Mixed mode). Depth gates 
are suitable for most environments. Range gates are ideal for shallow water bank to bank 
surveys, or when changing the Direction. A bottom search is performed between the Upper 
Gate and Lower Gate independently for each beam. When Depth mode is active, changing 
the Direction, or operating with a physically tilted head may drastically reduce the ping rate. 
To avoid this, select Range or Mixed mode. 

Upper Gate 

Sets the upper limit (minimum depth) for bottom detections. Change values by entering a 
number and press Enter, by using up/down arrows next to the corresponding control bar, or 
by interactively clicking and dragging the gate to the desired depth on the wedge. For most 
surveys the minimum should be at least 1m to avoid false detections at the surface. 
Minimum Value: 0.1m 
Maximum Value: 599m 

Lower Gate 

Maximum depth for calculating bottom detections. Change values by entering a number and 
press Enter, by using up/down arrows next to the corresponding control bar, or by 
interactively clicking and dragging the gate to the desired depth on the wedge. 
Minimum Value: 1.0m 
Maximum Value: 600m 

Swath 

User-defined total angular swath coverage. For typical harbor dredge surveys, this value is 
normally set to 120-150° 
Minimum Value: 5° 
Maximum Value: 210° 

Direction 

Direction of swath pointing angle. 0° places the swath symmetrically around nadir. Under 
normal operations, direction angle is dependent on swath width as no portion of the swath 
may exceed the 179° allowable view. If the survey requires that depth be attained above the 
sonar draft, the direction can be extended further up by first selecting 180° Swath. Next select 
the desired Direction, then select the final desired overall Swath. Useful when surveying 
slopes, shoreline or for mapping vertical structures. To maximize the ping rate while using 
this feature, it is recommended that Range mode be activated and regularly adjusted. 

Automatic 
Zoom 

Makes the active portion of the wedge full screen. This ensures that detections are clearly 
visible on the display, even when the range is very high. This is most effective when using 
Adaptive Ping Rate with a large lower depth/range gate. 

 
 

⚠ 

CAUTION:  Steering Direction Limited in Equidistant Mode 

In Equidistant mode, the swath angle cannot be increased such that any 
part of the swath exceeds an 80° pointing angle, i.e. 10⁰ from horizontal (so, 
a 160° swath with 0° rotation or a 120° swath pointed 20° is the maximum.) 
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 Backscatter Controls  

Backscatter Controls change the data dynamics and apply gain 
to fit in the dynamic range of the output data format (s7k). The 
sonar hardware has a limited time varied gain (TVG) which 
operates up to around 30m. Thereafter, TVG yields a constant 
level. This may be a problem for some processing software when 
creating seamless mosaics. The Apply TVG option removes this 
native sonar TVG applied by the hardware and instead applies the 
user specified TVG described by the mathematical formula: 
 

TVG = Spreading*Log10 (R) + 2*Absorption*R/1000 + Gain 
 

This TVG curve is a standard continuous function to let the signal fit in the data format (s7k) range 
and prevent signal saturation. This digital gain is applied to all imagery output data: side scan, 
snippets, snippet-side scan and water column. For most cases, a Static Gain setting of -15dB, 
spreading 40 and Absorption of 80dB/km will sufficiently scale the data.  
 

Function Description 

Apply TVG Removes the native sonar TVG that is applied in the sonar hardware and instead applies the 
user specified TVG, based on Static Gain, Spreading and Absorption. When TVG is 
applied, all parameters are reported along with the data to the acquisition software to process 
the data more effectively, e.g. for mosaicking. When the option is deselected, the native sonar 
TVG is not removed and no additional digital gain is applied to the data. Therefore, it is 
prudent to always enable this option. 

Static Gain Sets a fixed gain value that is used to together with Spreading and Absorption to form the 
TVG curve. The default setting of -15dB is suitable in most cases. Adjust this setting if the 
sonar signal becomes saturated, in which case the SS/WC/SN indicators will appear red on 
the main GUI display (see section 4.5.1). 

Spreading Sets the spreading component of the TVG calculation. Spreading loss is a geometrical 
phenomenon in which signal intensity is reduced as the range increases and wave fronts are 
spread over an increasingly larger area. The default setting is 40. 

Absorption Sets the absorption component of the TVG calculation. Transmission loss due to absorption 
is caused by conversion of acoustic energy into heat. The rate of absorption loss depends on 
the water environment and sonar operating frequency. The default setting of 80dB/km is 
recommended for 400kHz operation. 

Backscatter 
Mode 

Sets the backscatter mode to one of three options: None, Side Scan, or Snippet/Scan, the 
latter of which is a side scan composed of snippet data. Snippet collection rate will be limited 
to maximum 18Hz. These limits to data output rate were implemented to ensure smooth 
collection of data without burdening computational resources. If side scan data is requested 
by the acquisition software when Snippet/Scan mode is selected, Snippets-Sidescan will 
be generated so that (unlike regular side scan) a correctly positioned side scan can be derived 
from snippets data. When surveying with a NORBIT STX model, if snippets and/or side scan 
data are required, users are advised to deactivate Scanning under Tx Pulse Settings. If the 
goal is to classify bottom types, collection of Snippets will be most helpful. If that is not the 
case, snippets should be deactivated to conserve disk space and computational resources. 

View 
Backscatter 

Displays backscatter data under the sonar wedge. Even if it is not displayed in the GUI, 
backscatter data is still sent to the acquisition software if a TCP subscription is made. The 
SN/SS indicators at the top of the GUI appear green when a subscription is active. 

WC 
Resolution 

Sets the resolution of water column data. Water column data is output on record 7042. It is 
advised to keep the resolution low when computational resources are scarce. 

View WC Displays water column data on the sonar wedge. WC data collection is limited to 5Hz. Note 
that it will only be recorded to raw .wbm/.s7k files if the View WC checkbox is enabled. 
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⚠ 

CAUTION:  Snippets Is Data Intensive 

To ensure smooth data collection, make sure that the acquisition PC is not 
near its maximum CPU load. If CPU load is too great, artefacts may appear 
in the snippets record. 

 

 Tx Pulse Settings      

The Tx Pulse Settings control the acoustic transmission (Tx) 
signals. Typically, with default settings, these values are 
automatically determined based on sonar range. For most survey 
applications, these settings need not be changed.   
 
If the GUI detects a NORBIT STX model, this menu activates 
additional options to allow transmit pulse steering. These controls 
are not visible if a standard WINGHEAD or WBMS is detected. All 
functions are explained in the table below. 
 
For additional information on STX operation, refer to section 1.6. 

 

Function Description 

Frequency Sets the center frequency of the transmitted pulse. NORBIT sonars are optimized for a center 
frequency of 400kHz for standard systems and 200kHz for long range systems. For a given 
depth, higher frequencies theoretically have higher bottom detection resolution, but also 
higher signal attenuation, especially in the presence of sediments. For most applications, 
NORBIT recommends maintaining a frequency close to the center frequency. 
Standard Systems: 200kHz – 700kHz (optimized for 400kHz) 
Long Range Systems: 160kHz – 400kHz (optimized for 200kHz) 

Mode Sets the sweep time of the signal transmission. The available selections are FM Long Range 
(recommended setting for most applications), FM Short Range (applicable for surveys in very 
shallow water, <5m), or CW (legacy option). With FM Long Range, a long sweep time of 
500µs is applied. FM Short Range reduces the sweep time to 200µs. Reducing sweep time 
increases effective ping rate in very shallow water. For CW mode, the duration of the signal 
transmission increases range performance at the expense of detection quality. NORBIT 
systems are optimized for FM operation. 

Resolution Sets the acoustic range resolution by controlling pulse bandwidth. For FM modes, resolution 
is calculated as c/2*BW, where c is the speed of sound and BW is the bandwidth. When 
maximum resolution (0.9cm) is set in FM Long Range or FM Short Range modes, 80kHz 
bandwidth is used. Therefore, with a center frequency of 400kHz, transmission sweeps from 
360-440kHz. Decreasing resolution enhances range performance in deep water by reducing 
bandwidth. In CW mode, frequency transmission is constant. However, the system is 
designed from conception as an FM system and performs optimally in this mode, yielding 
highest resolution regardless of depth. Auto selection is recommended. 

Automatic 
Mode and 
Resolution 
(Auto) 

Adjusts Mode and Resolution for best performance in nearly all survey conditions, as 
determined by the software. For backscatter, unless very high ping rate is desired in shallow 
water, disable Auto and set Mode to FM Long Range and Resolution to 0.9cm to ensure 
full processing of the backscatter signal. The system will otherwise switch between 200µs 
and 500µs and some software cannot process out the signal change. 

Ping Rate Sets the rate at which acoustic pulses are transmitted. Certain factors such as depth will limit 
the maximum achievable ping rate. For instance, in deeper water, lower ping rates should be 
expected since signal travel time and path length from projector to seabed, and then back to 
receiver, are longer. Tx pulse Mode also affects ping rate. The system automatically transmits 
with 200µs sweep time in shallow waters so that maximum ping rate is maintained. 
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Ping Rate: 
Full Range 

If enabled, sets the ping rate to maximum possible value over the total effective range as 
defined by the Swath width, swath Direction and Lower Gate. Ping rate is a function of the 
two-way travel-time of the signal from projector to the bottom and back, plus a small duration 
for ping processing and capacitor charge. The effective range is determined from the angular 
swath width, swath pointing angle and lower depth or range gate. 

Ping Rate: 
Adaptive 

System searches for greatest bottom detection range based on adaptive gate over a certain 
number of pings and revises the transmission timing to match this. Lower Gate may therefore 
be set to very deep values, but the system will ping at a much higher rate as it is based on 
maximal adaptive gate for range. Ideal for high resolution data over rapidly changing bottoms 
or for surveys that do not allow for full-time, hands-on operators (e.g. on AUVs). While 
operating in this mode, sonar bandwidth and sweep time are determined by the Lower Gate. 
If surveying in shallow waters, the Lower Gate should not be set too deep unless Auto 
Mode/Resolution is disabled. 

Ping Rate: 
Fixed 

Sets the maximum ping rate of the sonar. Even if possible, the sonar will not ping faster than 
the fixed rate. Useful for general bathymetric surveys with deep and shallow water to reduce 
data volume in very shallow waters as the system will continually attempt to ping as fast as 
possible up to the user defined threshold or the sonar range. 

Ping Rate: 
External 

Ping is triggered externally and only happens if the sonar is ‘ready’ when the signal arrives, 
e.g. if the sonar cannot ping faster than 10Hz due to range, but the external signal is 12Hz, 
then every other event will be skipped resulting in a 6Hz ping rate per every other signal. The 
external signal polarity is configurable. Minimum delay from transmit signal to center of 
transmit pulse is 500µs (half the transmit pulse buffer plus additional). An adjustable trigger 
delay is possible in millisecond resolution. 

Scanning 
(STX only) 

Directs the sonar to sweep an along-track sector of angle given by Opening Angle. If 
unchecked, the sonar is directed to ping in one direction, effectively behaving as a 
conventional multibeam sonar. NOTE: It is not advised to perform an entire survey with 
scanning enabled. Use scanning only when attempting to further develop areas of 
interest. For most applications, step size should be limited to 20. 

Steps 
(STX only) 

This is configurable only if Scanning is enabled and the Opening Angle is set to a non-zero 
value. The number of steps corresponds to the number of slices, or pings, in each defined 
along-track sector. For most applications, use a step size equal to, or less than, 20. 

Direction 
(STX only) 

Defines the angular direction forming the center of the along-track sector, e.g. for a Direction 
of 5°, and Opening Angle 10°, the STX will scan across a sector from 0° to 10°. 

Opening 
Angle 
(STX only) 

Defines the angular sector through which the transmit beam is steered. Steering is limited to 

±10°, and as the angular Direction increases by 1°, the maximum Opening Angle decreases 

by 2°. If Direction is 0°, the maximum Opening Angle is 20°. 

Display all 
Ang (STX 
only) 

If checked, this instructs the GUI to display all angles in the sector being scanned by the STX. 
If unchecked, the GUI will display the angle defined in Display Angle. 

Display 
Angle 
(STX only) 

If Display all Ang is unchecked, this field will be greyed out. However, if the previous field is 
unchecked, the user may define a single angle within the sector to visualize on the display.  

 
 

⚠ 

CAUTION:  Data Quality Is a Function of TX Pulse Settings 

High quality sonar data requires excellent Signal to Noise (SNR). For most 
conditions (temperature & salinity dependent) use FM Long Range mode 
and 0.9cm resolution. If useable swath width becomes narrow, gradually 
decrease Resolution. If in doubt. use Auto selection. 
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⚠ 

CAUTION:  Bottom Classification Surveys Using Snippets 

For optimal backscatter data quality, deactivate Auto and manually define 
Mode and Resolution. Changing these settings during a survey, or 
operating in Auto mode, may cause degradation as the processing software 
is not able to compensate for variable pulse characteristics. In general, FM 
Long Range mode should be used, however this limits the ping rate to a 
maximum of 20Hz. If a faster ping rate is required, select FM Short Range. 

 

 Advanced 

If a NORBIT STX system is utilized, an additional checkbox appears 
for activating pitch stabilization. Note that pitch stabilization should 
not be used when Scanning is selected. 
 
When Multidetect is selected, additional options become available 
to control the detection sensitivity and customize the output. All 
functions contained are explained in the table below. 
 

 
 

Function Description 

Adaptive Gates Adaptive Gates work in a similar way to upper/lower gates, except they follow the 
shape of the seafloor. Note that they are not visible on the sonar wedge. If the gates 
are too narrow, bottom detections may be noisy for large depth changes. In areas with 
steep gradients it is recommended that the gates be turned Off. If the gates are too 
wide (or off), false bottom detections may occur due to noise, second returns or fish. 
The following applications are well suited for the corresponding settings: 

• Dredging Surveys: Normal Adaptive Gates 

• Engineering Surveys: Normal or Wide Adaptive Gates 

• General Bathy Surveys >40m: Narrow Adaptive Gates 

• General Bathy Surveys <40m: Normal Adaptive Gates 

• Wreck or Complex Structure Surveys: Wide Adaptive Gates or Off 

In some sea states the gates may need to be set wider to avoid cutting out data during 
large roll events. It is advisable to use adaptive gates in nearly all environments. 

Sound Speed Controls how the surface sound speed is applied. If Auto Sound Speed is selected 
(recommended) the sonar uses values from the integrated SVP. If this sound speed 
probe fails, users can disable the auto option and manually input the speed, based on 
a sound speed profiler for example. An incorrect surface sound speed will irreparably 
compromise data quality. Minimum value is 1300m/s, maximum is 1700m/s. When 
Auto Sound Speed is deselected, the last value at the head is used to populate the 
SV value. Please note that this range reflects default hardware capabilities. For marine 
conditions requiring a larger range, other models of the sound speed probe are 
available; please contact NORBIT Support for more information. 

Auto Sound 
Speed 

If this option is selected the speed of sound is read from the probe at the sonar head.  
This is recommended unless the probe is damaged, out of calibration or there are too 
many bubbles affecting the data quality, e.g. when surveying in rapids or surf-zone. If 
necessary, this option may be deselected, and the value set manually. If the sonar is 
powered on and out of the water, or there are excessive bubbles, the GUI displays a 
warning that the sonar is “Out of water”. If the sonar is pinging out of water, it 
automatically takes measures to prevent damage due to overheating. If the sonar 
temperature exceeds 65°C it will shut down automatically as a safety precaution. 
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Roll Stabilization Allows for a wider swath width in more dynamic sea states. Roll stabilization 
compensates up to ±10º of roll and is limited to 160º swath angle. Note that this is 
unrelated to roll compensation for georeferencing, which is handled separately. 

Pitch 
Stabilization 
(STX only) 

Allows for pitch compensated transmit beams for more even along-track coverage with 
minimal loss. STX scanning must be deactivated prior to use. 

Pulse Amplitude Sets the pulse amplitude (transmission power). For shallow waters (<10m) in highly 
reflective areas (lock chamber, for example) it may be necessary to reduce the pulse 
amplitude to reduce acoustic reflections/noise in the survey area. Otherwise it is best 
to leave it set to 15. 

Beam 
Distribution 

Several modes are available:  

• Equiangular 1024*/512/256: The angular swath coverage is divided equally 
by 1024, 512 or 256 (the total number of beams) to determine angular beam 
spacing. Use to increase resolution around the nadir zone. 

• Equidistant 1024*/512/256: The maximum chord distance of the swath is 
divided by 1024, 512 or 256 to determine the linear beam spacing. Use to 
increase resolution at outer swath edges. For WBMS systems there is a short 
1 second lag when switching modes. Do not switch while logging data. 

• Pipeline*: A combination of high-sounding density in the central swath region 

(±50°) where the pipeline is located and Equi-Distant distribution in the outside 

region. This allows more hits on the target, while still obtaining a general 
impression of the surrounding seabed. 

* Available for WINGHEAD sonars only 

Sonar Tilt Specifies the tilting angle in special mounting configurations such as dual head when 
the sonar is mounted at an angle. Allows the user to normalize the display in the GUI, 
otherwise a flat seafloor will appear as a slope. Note, additional considerations are 
required when the integrated IMU is tilted; refer to technical note TN-190018 for details. 

Multidetect Record up to 3 detections per beam - one additional detection above and below the 
bottom detection. The upper and lower gates control which part of the water column is 
considered for additional detections. Adaptive Gates control how close the additional 
detections are to the bottom detection: if set to Wide or Off, the additional detections 
could be further away from the bottom detection, and if set to Narrow, the additional 
detections are closer to the bottom detection. 

Multidetect 
Sensitivity 

Adjusting the slider increases or decreases the sensitivity of the multi-detection 
algorithm to qualify the water column as a potential extra detection. 

Multidetect in 
S7k Output 

Select whether to output an additional detection above (Upper) and/or below (Lower) 
the bottom detection in s7k files generated by the GUI. 

Options (Display 
Preferences, 
Timing and 
Triggering, 
Paths) 

Display Preferences 
 

Bottom Point Size – Changes the point size on the wedge. Adjustable from 1-10. 

Display Text Size – Changes the text size on the wedge area. Adjustable from 1-12. 

Roll Rotation – Viewing options to show the roll stabilized wedge. 

Water Column Data Image Quality – Sets the resolution of the water column display. 
This does not affect output resolution. To ensure system resources are kept to a 
minimum for low-grade field laptops, run with medium or low graphics selected. 

Units – Selects the display units in the GUI to be either metric or imperial. 

Bathymetry Quality Colors – Changes color palette of bottom detection quality 
flags. 

Color Map – Offers different color settings for visualizing the swath intensity data. 

Gamma Correction – Changes the visual contrast of the wedge intensity data. 
Setting the gamma too low will mute the intensity in the wedge display to nearly all 
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off (black). Setting gamma too high will fuse 
the darkest areas with brightest areas. A 
value of 2 is often the best. 

 
Timing and Triggering 

Users can specify the synchronization 
method for sonar timing. For more 
installations, 1PPS+ZDA should be 
selected, in which case the GNSS signal 
provides the time stamp and associated 
1PPS signal to the sonar. 
 
If timing direct from the SIU (via the GNSS 
receiver) is not possible, e.g. on ROV/AUV 
or other types of custom installations, then 
timing from an NTP Server may be used. Enter the IP address of the computer that 
runs the NTP service. 
 
NTP+PPS has the same accuracy as 
1PPS+ZDA and is recommended for all 
other installation types where 1PPS+ZDA is 
not possible. A PPS pulse must be sent to 
the system on the timing pin, and an NTP 
server should be made available on the 
network. If the timing error exceeds 10ms, 
the sonar will discard timing. Select 
NTP+PPS pos/neg if using time from an 
NTP server to provide PPS. “pos” and “neg” 
refers to a positive and negative signal 
spike, respectively. When this mode is 
activated, an error of >100ms renders the 
data unusable. 
 
If there is no PPS available, NTP without PPS can be used by selecting NTP Server. 
It possesses less accuracy but is OK to use for platforms with lower dynamics. This 
option requires that the NTP server is at a low STRATUM (<2) value and not too far 
away in the network (public servers are usually not good enough).  
 
More advanced users can use an external signal to trigger the sonar. The External 
Trigger polarity can be set to Rising Edge or Falling Edge. NOTE: For integrated 
systems, triggering via the BNC connector is not possible. Inputting any 
voltage to the BNC of an integrated SIU can cause damage to the internal 
electronics. 
 

Paths 

Users can specify the folder path for 
recording native NORBIT (*.wbm), INS 
(*.000), and s7k (*.s7k) files. 
 
Users can choose to disable INS data 
logging by deselecting GNSS/INS Raw 
Observables. However, NORBIT 
recommends that this option is always 
enabled. 
 
Note that the GUI must be closed/re-
opened when the recording path is changed, otherwise data will continue to be 
recorded to the previous location. 
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 Connection 

NORBIT sonars operate in a native data format. To ensure compatibility with other data acquisition 
and processing software, the system includes a proxy that 
translates native NORBIT sonar data to the well-known s7k data 
format. The proxy is therefore run from the GUI and is initiated 
automatically. The connection can be reset should a conflict arise. 
If necessary, to avoid conflict with other sensors, the Port number 
can also be changed. 
 
In a dual head configuration, the Port number set in the GUI 
applies to the primary sonar only. The secondary sonar port is one 
greater than the primary. For example, if the Port is set to 17000, the primary sonar will use port 
17000, and the secondary sonar will use port 17001. 
 
 

⚠ 

NOTE: Enable Force Push for PDS and EIVA Acquisition 

To receive sonar and INS data into PDS or EIVA, the Force Push option 
must be selected. 

 

 Connection Dialog & Connection State 

Select Sonar Connection to open the Connection Dialog (described also in section 4.3). Selecting 
Set Sonar Factory Defaults resets the sonar configuration but does not reset the integrated INS. 
NORBIT recommends restoring factory defaults whenever a new version of the GUI or firmware is 
installed. Note that, when this option is selected, raw GNSS/INS logging briefly terminates. 
 
Connection State contains basic information about the current connection status. If any of the 
indicators are red, action is required by the user. Such is the case in the example presented here, 
which shows that the sonar is not loaded with the firmware expected by the GUI. 
 
To shut down and disconnect the sonar, select Connection Dialog, select the sonar on the Known 
Sonars List, and select Disconnect. 
 

  
 
The Primary and Unlinked options relate to dual head operation. The Primary selection 
determines which sonar is master/slave. By default, any setting changes apply to both systems. 
The Unlinked option allows dual head sonars to be operated independently. 
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 Sonar Simulator 

The simulator is started via the Connection Dialog. Press Start Simulator, highlight the bathy 
simulator on the sonar list, and click Connect. You may receive an incompatible firmware warning; 
ignore this and click Connect Anyway. 
 
The simulator data can be used in acquisition software for testing and training purposes. The 
simulator does not output sound velocity, navigational or inertial data. Consequently, simulated 
sonar data will not be time stamped. 

 Playback 

The Playback tab displays all detected GUI recordings. If there are GUI recordings in other folders, 
USB drives, etc. select Browse and navigate to the correct folder. To 
play back a recording, double-click the file name. This opens a second 
display next to the active wedge. 
 
During playback, only bathymetry and water column data is displayed. 
By default, recordings are stored in: C:\Users\<user>\NORBIT\WBMS\ 

 
The playback window can be resized by dragging the central divider. 
Settings and Controls are found on the left. Users can also change the 
Sonar Orientation as required. To export the current ping, or a series of pings, use the Export 
Current Ping and Export buttons. Other options including s7k export and video export are found 
on the left menu, while playback controls are displayed at the bottom: 

 

 

 Log, Info & Version 

The Log tab contains a record of system events. The Info tab contains a record of serial numbers, 
part numbers, revision numbers, and various system statistics. The Version tab displays the current 
NORBIT GUI and firmware versions. 
 

   

Go to the beginning 

Step backward (1 ping) 

Play / Stop Step Forward (1 ping) Insert Tag/Comment 

Open Zoom Control 

Insert a Duration Tag 

Repeat Playback 
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 Presets 

Users can save preferred sonar configurations by selecting Save Config. These files can be loaded, 
as and when needed, by selecting Load Config. Saved configurations are stored in: 
%appdata%\NORBIT\PredefinedSonarSettings\ 
 
Configuration files contain all sonar settings (frequency, swath 
angle, static gain, etc.) and all GUI display preferences. Users may 
transfer files between computers to load desired presets. This 
functionality allows rapid reconfiguration of the sonar. 
 

4.7 Data Formats, Recording & Output 

 Raw Data Recording 

Bathymetry data with full motion and navigation data, including True Heave data (for integrated INS 
systems only) can be recorded in the native NORBIT format with extension *.wbm. At the same time, 
s7k files are generated automatically. The s7k format has a publicly available data format definition 
(DFD). If requested, NORBIT Support can provide documentation on the DFD. The logging location 
for *.wbm, *.s7k and *.000 files can be changed by selecting Advanced > Options > Paths. See 
section Advanced for more details. 
 
Stored data types depend on selections made in the Backscatter Controls settings.  The View WC 
Checkbox controls whether compressed water column data is recorded, and the Backscatter Mode 
controls what backscatter imagery is recorded. This is only relevant for raw data files recorded in 
the GUI and does not affect data output to acquisition software (see Data Output via Network 
Subscription.) 

 
All acquisition software subscriptions overwrite selections made in the GUI. Therefore, if the GUI 
does not have Side scan selected for Backscatter Mode, but side scan is requested by the 
acquisition software, side scan will be recorded in the raw data files regardless. 
 
Note also that bathy intensity values, at the bottom detection point, are recorded within the 
bathymetry data packets. This is automatically output and requires no configuration in the GUI. It 
can be used to provide coarse backscatter, separately from the side scan and snippets outputs. 
 

Backscatter 
Mode Selection 

View WC 
Checkbox 

Recorded Data Types in WBM file 7k Records in s7k file 

None ☐ 
✓ Bathymetry 

✗ Water Column 

✗ Side scan 

✗ Snippets 

✓ 7027 

✗ 7042 

✗ 7007 

✗ 7028 

None ☑ ✓ Bathymetry 

✓ Water Column 

✗ Side scan 

✗ Snippets 

✓ 7027 

✓ 7042 

✗ 7007 

✗ 7028 

Side scan ☑ 
✓ Bathymetry 

✓ Water Column 

✓ Side scan 

✗ Snippets 

✓ 7027 

✓ 7042 

✓ 7007 

✗ 7028 

Snippets/scan ☑ 
✓ Bathymetry  

✓ Water Column 

✓ Side scan 

✓ Snippets 

✓ 7027 

✓ 7042 

✓ 7007 

✓ 7028 
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 Data Output via Network Subscription 

Currently, the NORBIT GUI supports streaming s7k 
records 7000, 7004, 7006, 7007, 7027, 7028, 

and 7042 via the subscription model (record 7500 with 

ID 1051). All subscriptions can be ended with record 
7500, ID 1052. 

 
Supported single request records (via record 7500 with 

ID 1050): 7001 

 
Successful requests are replied with record 7501 (ACK) 

while unsuccessful requests return record 7502 

(NACK). This is based on the DFD version 2.43.  The 
adjacent table lists the current s7k records output by the 
Proxy Server in the NORBIT GUI. 

 Data Rates 

Estimated data rates for a single head iWBMS system at maximum ping rate are given below: 
 

Ping Rate Bathy INS WC SS SN SNS Data Rate 

50 Hz ✓ ✓ ✗ ✗ ✗ ✗ 5 Mbps 

50 Hz ✓ ✓ ✓ ✓ ✗ ✗ 13 Mbps 

50 Hz ✓ ✓ ✓ ✓ ✓ ✗ 13 Mbps 

50 Hz ✓ ✓ ✗ ✗ ✗ ✓ 11 Mbps 

 

4.8 Interfacing with Multiple Computers 

It is possible to communicate with the GUI using more than one computer, e.g. one computer to 
configure and control the sonar and a second, more computationally resourceful PC, to run 
acquisition software such as DCT, HYPACK or Qinsy. It requires a network switch and an Ethernet 
cable for each connected computer. 

 
 
Each computer requires its own unique IP address on the same IP range (see section 4.2 for more 
details). The acquisition software should always connect to the IP address of the PC that operates 
the GUI, on TCP port 7000. 

 

 

 

Record Description 

7000 Sonar settings 

7004 Beam Geometry 

7006 Bathymetry data (obsolete) 

7007 Side scan data 

7027 Bathymetry data (including bathy 
intensity values) 

7028 Snippets data 

7042 Compressed water column data 

7500 7k remote control with ID 1051 

7501 7k remote control acknowledge  

7502 7k remote control not acknowledge 

Network 
Switch 
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 Troubleshooting 

If the below troubleshooting steps fail to resolve the problem, contact NORBIT Support and include 
as much information as possible, including relevant photos, screenshots and data recordings. 

5.1 Sonar Issues 

Problem Action 

Sonar or GUI does not 
behave as expected 

• If sonar is connected but not behaving as expected, perform a factory 
reset. Select Set Sonar Factory Defaults on the Connection dialog to 
clear the configuration. 

Cannot connect to the 
sonar 

• Verify SIU is powered on. 

• Check that cable connections are free from corrosion, properly secured, 
and that pings are not bent. 

• Check for IP address conflicts. The network card on the PC should be 
configured to 192.168.53.XXX where XXX is neither 100 (INS) nor the 
sonar serial number. 

• If using a network switch, bypass the switch and connect directly to the 
computer to check for faults with the switch. 

• Reboot PC, wait 30 seconds, then power-cycle the system. 

• Open Windows Command Prompt and type ping 192.168.53.XX (XX 

being the last 2 digits of the sonar serial number). This indicates whether 
the sonar is detectable by the acquisition PC. 

• Ground SIU, as explained in section 5.3. 

Sonar does not power 
up, or power is lost 
during operation 

• Check power supply voltage with a voltmeter. 

• Depending on the power source, check the battery/inverter for failure and 
replace. 

• If power is <12V or >28V, power LED on SIU blinks at 5Hz. Test system 
using an alternative power source, e.g. power from a wall outlet or fully 
charged battery. 

Data quality issues 
(motion artefacts, etc.) 

• Ensure that multiple network cards (Wi-Fi and wired) are NOT connected 
to the same subnet. This causes duplication of navigation data in the files. 

• Review physical installation, ensuring that mounting structure is rigid and 
free from vibration. 

• Check that there is no independent movement between GNSS antennas, 
and review the antenna separation (2m is ideal) 

• Review offsets and positioning quality 

• Review Data Quality Control Checklist. 

GUI does not match 
description or is not 
performing as 
described 

• Obtain latest installer from NORBIT Support. 
 

IMU is connected but 
there is no sonar 
connected 

• Check cable connections and re-seat if necessary. 

• Possible IP address conflict. Check network settings. 

• GUI and BathyProxy should be allowed in Windows Firewall. 

• Ground SIU, as explained in section 5.3. 

There is no timing in 
the sonar or GUI timing 
line is red 

• Check pins on cable and SIU. If a pin is bent, VERY gently bend it back. 
*This may result in damage, so do so at own liability* 

• Go to INS Tools > Sky Plot and check that satellites are detected on both 
GNSS antennas. 

• Check that PPS LED on SIU is blinking at 1Hz (see section 2.3.6 for more 
info.) 

• If satellites are detected but LED is not blinking at 1Hz, open POSView 
and check COM4 output to verify that it is configured to output NMEA ZDA 
at 1Hz, 9600 baud. 
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• Users can also obtain reliable NTP timing from Qinsy SNTP, which does 
not require a license. Open Qinsy and double-click SNTP Server. If server 
does not start, change UDP port in Options menu. Once server is running, 
go to the NORBIT GUI, select Advanced > Options > Timing and 
Triggering, select NTP+PPS pos, select the IP of the PC running the 
server, and click Apply. Another recommended source of external, free 
timing server is Meinberg. 

Surface SV sensor is 
not connected or shows 
incorrect values 

• Check SV sensor connection and tighten if necessary. 

• Stop vessel to allow air bubbles to dissipate to see if reasonable values 
return. Adjust mounting to reduce bubble formation. 

• Inspect sensor for visible damage. Any distortion in the sensor may cause 
incorrect measurements. 

• Check for foreign objects or debris on the sensor.   

Sonar display freezes 
and data packets are 
dropped 

• Run Windows Task Manager to check if unnecessary programs or 
processes are consuming excessive network bandwidth. 

• Bad switch, hub or cable. Replace. 

• Update computer network card driver. 

• Select Set Sonar Factory Defaults on the Connection dialog. 

Network disconnection 
errors occur, or no data 
from sonar and/or IMU 

• Check sonar and/or IMU cables. Check that the connection at wet-end is 
tight. If it has loosened, remove connection, clean threads at both male 
and female fittings and apply a very small amount of grease (O-Ring 
grease mentioned in this manual works well), then re-tighten. If fingers 
are weak from cold, then use a tool, but do not overtighten! 

Soundings are being 
filtered 

• Adaptive gates are on Narrow and may need to be changed to a wider 
setting, or disabled altogether. 

Bottom detection 
quality is degraded 

• Check sonar head for marine biofouling. Clean barnacles off gently. 

• Check that sonar cable connectors are clean, dry and properly seated. 

Lower Gate is beyond 
expected depth, but no 
bottom is detected 

• Lower the upper gate closer to the expected bottom.  

No external roll 
stabilization with 
standalone (non-
integrated) NORBIT 
sonars 

• Follow the instructions in section 4.4.6. 

• Use terminal emulator such as PuTTY (free to download) to verify the 
TSS1 message data stream. Select a “Serial” type connection, enter port 
number and baud rate of the data source, and select Open to display the 
data stream. 

Data is received in 
NORBIT GUI, but data 
is not received in 
acquisition software 

• Ensure that both firewalls (Private and Guest or public networks) are 
disabled. 

• Check to see if acquisition software has correct ports specified. 

“Sonar timing incorrect” 
pop-up window remains 
when satellites 
detected 

• May happen if INS boots-up slower than the sonar. Close the pop-up 
window. If sonar timing is incorrect, the timing row in the main GUI display 
will remain red.  

No sonar data in PDS 
or EIVA 

• Ensure that Force Push is checked under Connection settings in GUI.  

Smears appear in the 
snippets record 

• PC load is too high, and it is unable to properly process the high data 
load. Try reducing PC load by closing unused programs and non-critical 
windows in the acquisition software. Slower computers may not be able 
to handle the data load. 

Text in GUI appears 
too condensed 

• In Windows, go to Change Display Settings, and change the Scale and 
Layout values. Change the value under “Change the size of text, apps, 
and other items” 
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5.2 INS Issues 

Problem Action 

Sonar is 
connected but no 
INS data is 
received 

• Disable Windows firewall, or allow NORBIT GUI access and add an exception 
for UDP port 5602: 
▪ Open legacy Windows Control Panel 
▪ Go to System and Security > Windows Defender Firewall 
▪ Choose Advanced Settings on the left menu 
▪ Create a new Inbound Rule 
▪ Select “Port” and click Next 
▪ Apply the rule to UDP port 5602 and click Next 
▪ Select “Allow the connection” and click Next 
▪ Apply the rule to Domain, Private and Public, and click Next 
▪ Specify a rule name and Finish the wizard 

• Open Windows Command Prompt and type ping 192.168.53.100. This 

indicates whether the INS is detectable by the acquisition PC. 

• Check network configuration and ensure that computer IP address does not 
conflict with the INS IP address (192.168.53.100). 

• Check cable connections and re-seat if necessary. 

• Check for bent sonar cable pins. 

• Possible IP address conflict. Check network settings. 

• Ground SIU, as explained in section 5.3. 

• Go to INS Tools > INS Setup Wizard and select Factory to restore default 
settings. 

• Perform the “resistance test” to check status of circuit components. Refer to 
Appendix for pinout diagrams. 

Unable to receive 
RTK corrections 

• Check COM port settings. 

• Check cable connections. 

• Verify IP address and mount point if using network solution. 

• Check radio link, check frequency, and verify that baud rates and corrector 
types match. 

• Try with Null Modem to swap pins 2/3. 

• Check on a different unit to verify data stream. 

• For serial RTK data, use terminal emulator such as PuTTY (free to download) 
to verify the data stream. Select a “Serial” type connection, enter the port 
number and baud rate of data source, and select Open to display the data 
stream. 

• If using NTRIP, check the Internet connection and verify login details. 

Unable to achieve 
successful 
heading alignment 

• Check antenna connections, ensure that antennas are connected to correct 
primary/secondary sockets.  

• Verify offset measurements. 

• Reset INS to factory defaults and start configuration over. 

• Review GNSS environment. Try different area or time. 

No GNSS Data in 
INS System  

• Check cables and ensure that all connections are secure. 

• Use only antennas provided with kit. Other antennas may not work. 

• Ensure that antennas have clear sky view with no obstructions. 

System status 
shows faults 

• Check that cables are secure and tight. 

• Check for bent pins on cable and SIU. 

• Low quality power supplies may cause this issue. Try alternative power source. 

• Possible damaged sonar cable. 

• Ground SIU, as explained in section 5.3. 

INS Logging light 
is red or orange 

• Open INS Setup Wizard and apply Factory defaults. 

• Reboot PC. 

• Disable Windows Firewall. 
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5.3 Grounding 

In some cases, the SIU may need grounding for proper operation. Grounding issues 
may cause IMU failures and bootup issues. If there is no grounding screw on the SIU, 
NORBIT recommends using a BNC connection. Find a BNC cable, break off the pin 
inside the connector, and on the other end expose the ground shielding (using the outer 
braid of wires) and crimp a connection to them. Connect the BNC to the SIU and the 
other end to a metal part of the vessel, or a wire that is in the water. 

5.4 Change Sonar IP Address 

Log onto the sonar with telnet. To do this, press Windows+R to open the Run dialog. Type cmd to 

open command prompt and use the following commands: 
 

Telnet 192.168.53.XX (where XX is the last two digits of sonar wet-end serial number) 

fw_printenv (prints to screen all u-boot parameters) 

 
Options: 

fw_printenv ip_addr (print to screen all ip_addr parameters) 

fw_setenv ip_fallback 192.168.53.99 (sets IP to 99 if no DHCP server on network) 

fw_setenv ip_addr 192.168.53.99 (sets static IP to 99 regardless of DHCP) 

5.5 Data Quality Checklist 

Should the acquired data quality be degraded, review the steps below: 
 

1. Review Hardware Installation: Ensure that all sensors are fixed, rigid, and free from 
vibration. There must not be any independent movement of sensors. 

2. Primary Antenna: Ensure that the primary antenna is closest to the NORBIT system and 
connected to the correct SIU port (Ant 1). 

3. Network Configuration: Ensure that multiple network cards (Wi-Fi and wired) are NOT 
connected to the same subnet. This causes duplication of navigation data in the files. 

4. Offsets: Measure offsets correctly to the nearest 1cm or better, and check that the sign 
inputs are correct. 

5. Alignment: Ensure that the integrated system is closely aligned with the vessel centerline. 
Agreement to within ±0.5° is ideal. 

6. Center of Rotation: If the sonar and IMU are not mounted at the CoR, measure and apply 
this offset in the INS Setup Wizard to eliminate heave artefacts. 

7. GNSS Corrections: Only Narrow Lane RTK is suitable for RTK tides. Position errors 
increase with distance from the base station. DGNSS is accurate only to about 60cm 
horizontally. Ideally use a post-processed kinematic solution. 

8. Sound Speed: In many environments, sound speed varies more in the upper layer of the 
water column. Mounting the sonar lower helps to overcome errors related to unaccounted 
changes in sound velocity. Perform SV casts on a regular basis and compare them to the 
surface sound speed, ensuring that the difference does not exceed 1m/s. 

9. Patch Test: Review multibeam roll, pitch, and yaw misalignments. Repeat measurements 
as and when required. Generally, roll should not vary by more than ±0.02°, pitch by ±0.1° 
and heading by ±0.5°. Perform a patch test every time the sonar and IMU are moved. 

10. Swath Angle: Soundings are most accurate if they are within a ±70° sector from nadir 
(depending on water depth), or wider if the beam footprint and incidence angle are very 
small, e.g. when the swath is perpendicular to a steep shoreline sloping up from nadir. 
Soundings sloping down from nadir have a large footprint and incidence angle. It is always 
better to ‘look’ up a slope than down one, and therefore survey lines should generally be 
parallel to the bottom contour. 
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 Basic Acquisition Software Setup 

6.1 Offsets 

By default, integrated NORBIT systems output all sonar and navigation data at the Sonar Reference 
Point (refer to the Offsets section for more details). Therefore, each device in the acquisition software 
requires the same offset; that is, the offset from the acquisition software reference point (e.g. Center 
of Rotation) to Sonar Reference Point. If the optional iLiDAR is installed, this offset must be 
separately measured and applied. 
 
If the acquisition software and sonar reference points are the same, no offsets are required. In 
HYPACK, the vertical offset is the same for all systems and should be measured from the waterline 
to the Sonar Reference Point. 

6.2 Data Collection Tool (DCT) 

DCT is a web-based survey acquisition utility, developed by NORBIT, aimed to simplify standard 
bathymetry survey operations. A grid can be displayed on any computer or mobile device allowing 
quick estimation of survey coverage and data quality in real-time. Unlike other data acquisition 
packages, DCT requires no setup or offsets; all data is output with WGS84 coordinates and depth 
below sonar. 
 
To enquire about DCT, please contact NORBIT Support. Refer to the dedicated DCT manual for 
operational guidance. 

6.3 HYPACK 

The following sections show only one of many possible methods for configuring HYPACK for 
NORBIT sonars. It assumes that the INS reference is collocated with the Sonar Reference Point. 
The vertical offset should be measured from the waterline to the Sonar Reference Point, and is the 
same offset for all systems (navigation, attitude and multibeam). 
 
Note that the HYPACK sign convention uses +Forward, +Starboard, and +Down. Incorrect entry 
of the sign may corrupt data 
 

Step 1. Enable HYSWEEP Survey 
Check Include under HYSWEEP Survey. This allows devices to be added for multibeam surveys.   
 

  
 

Step 2. Define Boat 
Select Boat and give it a name. For more intuitive visualization, add a tracking point, preferably to 
the Sonar Reference Point (for standard installations). Edit Vessel Shape as appropriate.  
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Step 3. Configure Position and Heading Device 

In Survey Devices, add the Applanix POS M/V Network device and configure it as shown below.  
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Step 4. Configure HYSWEEP Interface 

Then add, and configure, HYSWEEP Interface, checking only the Depth function under Functions: 
 

   
 

Step 5. Configure Motion Device 
In HYSWEEP Survey, add the Applanix POS/MV Network device and configure it as shown below: 
 

 
 

  
 
Step 6. Configure Multibeam Device 

Go to HYSWEEP Survey and select NORBIT WBMS, as shown below. In WBMS Setup, select 
Sidescan Recording for recording Sidescan only, or Snippet SS Recording for Snippet-
Sidescan, or Snippet Recording for logging Snippets. If Snippet data is requested, users must 
also select Log Datagrams. Note that bathymetry data automatically includes bathy intensity 
values at the bottom detection point, which provides coarse backscatter. 
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6.4 Qinsy 

The following sections show recommended configurations of Qinsy v9.2 for all NORBIT sonars. It 
assumes that the INS reference is collocated with the Sonar Reference Point. Note that the Qinsy 
sign convention uses Y+ Forward, X+ Starboard, and Z+ Up. 
 
Qinsy structures all data in a native database format. All data and hardware settings including offsets 
are saved to a database file. 
 

Step 1. Configure Geodesy 
Access the Geodetic Configuration from the Qinsy console and specify the relevant geodesy. 
 

Step 2. Object Definition 
From the Qinsy console, select Setup > New Database Specify the shape of the vessel and the 
reference point for Qinsy (e.g. vessel center of gravity) 
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Step 3. Add Multibeam System 
Specify a system name, e.g. NORBIT, and select Multibeam Echosounder as the type. Select the 
Reson SeaBat 7k (TCP/Network) driver, use port 7000 and IP address 127.0.0.1. 
 

  
 

Under Raw Data Recording, for standard bathymetric data collection select the NORBIT System 
and None for Packet Storage, Water Column and Snippets. 
 

Step 4. Configure Snippets and/or Water Column Recording (Optional) 
To collect water column, select the 7042 (Compressed) option. To collect snippets but no water 
column, configure the system as shown below (left); or for snippets and for water column (right) 
 

  
 

Step 5. Enter Offset to Sonar Reference Point 
In Multibeam Echosounder Parameters, click the + button to create a node. Patch test values (roll, 
pitch and heading) may be entered if known. Enter 1024 under max beams per ping. Use the default 
echosounder accuracy and correction values. Click Finish. 
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Step 6. Add Side Scan System (Optional) 
Related systems may now be added. To add side scan, a port and starboard channel should be 
added and the frequency should be specified. Items marked with an asterisk (*) will not impact the 
data and are only for record keeping. Click Finish when done. 
 

   
 
Step 7. Add Pitch/Roll/Heave System 

From the Database Setup window, right-click System, click New System and add a Pitch/Roll/Heave 
sensor. Please note that for Applanix systems, the sign convention is positive downwards: 
 

   
 
Step 8. Add Gyro Compass System 

Repeat the previous step to add a new system, but this time add a Gyro Compass: 
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Step 9. Add Position Navigation System 

Repeat the previous step to add a new system, but this time add a Position Navigation System. The 
Horizontal and Vertical datum will obviously depend on project specifications. 
 

  
 

Step 10. Output Quality Information (Optional) 
To configure the sonar to output quality information, add a Miscellaneous system: 
 

   
 

Step 11. Add Time Synchronization System 
A time synchronization system must be added. Use binary group 7 without a PPS box. 
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6.5 PDS 

The NORBIT GUI requires that Force Push be enabled in the NORBIT GUI Connection settings to 
receive data in PDS. Refer to section 4.6.5 for more information on its functionality. 

 
Note that the PDS sign convention uses Y+ Forward, X+ Starboard, and Z+ Up. Incorrect entry of 
the sign may corrupt data. The Applanix Ethernet groups required by PDS are automatically 
configured on integrated NORBIT systems, thus no action is required. 
 
The Sea Level offset is used when depths are reduced using tide and heave. When RTK heights 
are used for depth reduction, the Sea Level offset is only used for applying the sound velocity profile 
at the correct depth. 
 

Step 1. Create New Project and Setup Geodesy 
Create a new project in PDS Control Center via File > New Project. Specify a name for the project, 
and on the next page select a coordinate system from the geodatabase or define a new coordinate 
system according to the survey requirements. 
 

  
 

Step 2. Select Application Type and Run Configuration Wizard 
Select Multibeam Acquisition as the application type. Click Next and run the configuration wizard. 
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Step 3. Add New Vessel 
Specify a name for the configuration (e.g. “Survey Vessel Pole Mount”) and on the next page add a 
Local vessel which will contain all drivers and offsets. 
 

 
 

Step 4. Enter Offsets 
On the Geometry page, define the shape of the vessel (only for display) and enter the Center of 
Gravity offset as measured from the Sonar Reference Point. Leave the CoG Z field zero to keep the 
setup simple, as the Sea Level offset is defined in relation to the CoG. Then enter the Sea Level 
offset relative to the Sonar Reference Point. This should be a positive value. 
 
If the optional iLiDAR is installed, add its offset to the list. This is the measured offset from Sonar 
Reference Point to iLiDAR Reference Point. Refer to the iLiDAR manual for more details. 
 

 
 

Step 5. Add Essential Devices 
Devices for each data type are added on the Equipment list. On the left side, select the Group and 
then select the driver to add. As a minimum, the following drivers are required: 
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Group Driver I/O Port Offset 

Positioning system Geogs PosMV all coupled modes- ethernet msg 
3+10+12+20+102+104[pos] 

192.168.53.100 
UDP 5602 

Zero Offset 

Compass PosMV ethernet 3+102+104[hdg] 192.168.53.100 
UDP 5602 

Zero Offset 

VRU PosMV ethernet 3+102+104[vru] 192.168.53.100 
UDP 5602 

Zero Offset 

Multibeam NORBIT using RESON 7k protocol (1) [mbs] 127.0.0.1 
TCP 7000 

Zero Offset 

 

 
 
Step 6. Add Optional Devices 

Optional drivers may be added for snippets or side scan data, true heave data, and LiDAR data:  
 

Group Driver I/O Port Offset 

Snippets NORBIT using RESON 7k protocol (1) [snp] 127.0.0.1 
TCP 7000 

Zero Offset 

Sidescan Sonar NORBIT using RESON-7k protocol (1) [sss] 127.0.0.1 
TCP 7000 

Zero Offset 

Heave PosMV ethernet 3+111[heave] 192.168.53.100 
UDP 5602 

Zero Offset 

Laser Scan Velodyne LiDAR VLP-16[laser-scan] 192.168.53.101 
UDP 2368 

iLiDAR 

 
Step 7. Configure I/O Ports 

Select each device on the Equipment list and click I/O Port to configure the interfacing parameters, 
as per the tables in the previous sections.  
 

   

Applanix Devices Multibeam Devices iLiDAR 
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Step 8. Configure Device Properties and Apply Offsets 

For each device on the Equipment list, click Edit to open the Device Properties. Here you must select 
the offsets to apply, as defined previously on the Geometry setup. Recall that all applied offsets 
should be zero, except the optional iLiDAR. 
 

   
 
The patch test values, if known, may be entered in the device properties for the multibeam and 
optional iLiDAR. They should be entered in the Roll Correction, Pitch Correction, and Heading 
Correction fields. 
 

Step 9. Configure Optional LiDAR Properties 
If the optional iLiDAR is installed, the orientation base must be set in device properties. This should 
be set to Down-Across assuming the scanner is installed in the standard configuration with 
connector aft. Refer to the PDS manual for more details. 
 

Step 10. Configure Height Source 
Select Reference Point Computation under the 
positioning device and double click, or press Edit. 
The height source can be set to GPS Height [RTZ] 
if RTK positioning is available, and if you wish for 
these heights to be used for depth reduction. 
Otherwise, set this to None. 
 
Height Standard Deviation Mask is a user-defined 
quality threshold for utilizing RTK heights in the 
depth calculation. By default, it is set to 0.1m, which 
means that the GPS Height source will only be 
applied if the altitude quality reported by the sensor 
is <0.1m. To ensure that RTK heights are always 
used regardless of reported quality, set the deviation 
mask to a high value, e.g. 10m. 

 
Step 11. Complete the Wizard 

Now the essential steps are complete. The next pages of the wizard contain optional setup steps, 
details of which are available in the PDS manual. Finish the wizard to return to PDS Control Center. 
To return to these settings and modify the vessel configuration, click the gear icon on the toolbar.  

 

 

Multibeam Properties iLiDAR Properties 
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6.6 EIVA 

The NORBIT GUI requires that Force Push be enabled in the NORBIT GUI Connection settings to 
receive data in EIVA. Refer to section 4.6.5 for more information. Note that the EIVA sign convention 
uses +Up. Incorrect entry of the sign will cause georeferencing errors. 

 NaviPac 

Step 1. Add Surface Navigation Instrument 
Add a surface navigation instrument to the vessel. Select POSMV Group 1 from the list, and use IP 
address 192.168.53.100 on UDP port 5602 for the I/O Settings. 
 

  
 

Step 2. Add Gyro and Motion Instruments 
Repeat the above step for Gyro and Motion, using the POSMV Gyro 102/3 and POSMV RPH 102/3 
options. 
 

 

 NaviScan Config 

Step 3. Add Navigation Sensor 
Begin by adding the navigation sensor. Go to Equipment > Add Sensor and select the Applanix 
option. For port settings, enter the IP address 192.168.53.100 and UDP/IP Port 5602. 
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Step 4. Add Gyro Sensor and Motion Sensor 
Repeat the previous step to add the Gyro sensor and Motion sensor. Select the Applanix options 
and configure the network settings as per the previous step. 
 

   
 

Step 5. Add Echosounder 
Add an Echosounder sensor, selecting the Norbit RawRange 7027 option. In port settings, select 
TCP/IP Port, enable Local, and use port 7000 (unless configured otherwise in the NORBIT GUI). 
For dual head operations, select the Norbit RawRange 7027 Dual option. 
 

   
 

Step 6. Time Synchronization 
If NaviPac and NaviScan are on the same computer, Ethernet timing can be used for time 
synchronization. Add a GPS Time sensor and select the Applanix option, using the same port 
settings as the other Applanix sensors. The final NaviScan project tree is shown below. 
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Appendix A: Quick Start Guide 

Standalone WINGHEAD or WBMS users should skip sections related to INS configurations. 
 

1. Unpack and Inspect: Unpack sonar system and inspect all cables and connectors for damage, dirt 
and moisture. Inspect the transducers for cuts or gouges.  

2. Sonar Installation: Make an installation plan. Mount sonar on the vessel and align unit so that it is 
parallel with the vessel keel with the projector pointing aft. Bolt sonar bracket to pole with minimum of 
4 bolts. Use lock-washers and/or Loctite 242, especially for longer duration setups as nuts will vibrate 
and loosen over time. Users are advised to connect wet-end cables before mounting the system to 
simplify the process of securing cables.  

3. Antennas: For GNSS/INS integrated systems, mount the GNSS antennas with 5/8” threaded bolts. 
While not necessary, it is helpful to align GNSS antennas to be parallel or perpendicular to vessel keel. 
The antenna closest to the sonar is typically the primary. Connect the primary antenna to Ant 1 on the 
SIU, and the secondary antenna to Ant 2.  

4. Cables: Run cables from sonar and antennas to SIU. Avoid sharp bends and beware of chafing. 
Handle cables with care; rough handling will bend connector pins and may cause damage. Do not run 
cables next to high voltage lines – spread cable out to avoid RF interference. 

5. SIU & PC: Connect the SIU to the control and acquisition PC via Ethernet. Before powering the sonar, 
set the IP address of the PC to 192.168.53.XXX, where XXX can be any number from 101 to 255, and 
set the subnet mask to 255.255.255.0  

6. RTK: If RTK positioning is used, configure it as required. 

7. Offsets: For the default setup, measure XYZ offsets from Top Center of 
Bracket to the base of primary GNSS antenna. 

8. Power: Ensure power source is clean. Beware of batteries that are under 
powered or cheap inverters. 

9. Software: Install the NORBIT GUI and disable Windows Firewall. With all 
hardware connected to the SIU, power it on and open the NORBIT GUI. 
Connect to the sonar via the Connection dialog. Once connected, the GUI starts 
logging raw GNSS/INS observables automatically. 

10. INS Setup: Open the INS Setup Wizard under INS Tools. Follow the prompts 
and have the measured offsets, from Top Center of Bracket to the base of 
primary antenna, at hand. For the baseline vector, select Alignment Wizard. This ensures that the 
heading alignment starts automatically once the INS Setup Wizard is complete. 

11. Acquisition: Setup your acquisition software of choice, e.g. DCT, HYPACK or Qinsy. Select the Norbit 
driver (or Reson SeaBat 7125 network driver, if that is not available) and connect to the GUI IP address 
(typically 127.0.0.1) on TCP port 7000. 

12. Tides: For verification that the INS system is ready for survey in RTK mode, it is a good practice to 
examine a time series graph of RTK tide values. As soon at the graph stabilizes on a narrow value 
range, the system is ready for survey.  

13. Bar Check: Run a bar check to validate sonar draft. 

14. Sound Speed: Verify the sound velocity reported by the sensor on the sonar by comparing it to 
another sensor, e.g. a sound velocity profiler. 

15. Patch Test: Perform a patch test each time the sonar is installed or moved from its previous location. 
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Appendix B: Dual Head Quick Start Guide 

 
1. Bracket and Mount: Mount the sonars to the dual head bracket or two single head brackets. 

2. Power: For WINGHEAD configurations, two SIU-WH are required. If a single SIU-I-NAV is used for 
dual head iWBMS, it must be revision 5 or later, and must be supplied with 24VDC. Note that, in this 
case, the standard power brick provided with a single head system (120W) does not provide sufficient 
power for dual head (220W). 

3. Antennas: Install the antennas with 2m separation, ideally. 

4. Cables: Secure, direct and connect all cables to the SIU. The sonar 
cable of the secondary sonar can connect to the Aux port of the SIU-
I-NAV for dual head iWBMS. 

5. SIU & PC: Connect the SIU to the control and acquisition PC via 
ethernet. Before powering the sonar, set the IP address of the PC to 
192.168.53.XXX where XXX can be any number from 101 to 255, 
except 100 which is reserved for the GNSS/INS, or the last two digits of 
the sonar serial number. Set the subnet mask to 255.255.255.0.  

6. GUI: Install the NORBIT GUI and, with the SIU powered on, run the GUI 
to detect and communicate with the sonars. On the Connection 
Dialog, select the two online sonars (highlight them on the table) and 
define the Primary sonar. Click Connect. 

7. INS Setup: Complete the INS Setup Wizard, adjusting the offsets and 
IMU rotations accordingly if the integrated IMU is tilted. Consult the 
technical note TN-190018 for details on adjusting the offsets. If you do 
not have this document, please contact NORBIT Support. 

8. Sonar Controls: Two swaths appear in the main display with the 
primary sonar appearing on the left. Thus, visualization is more intuitive if the primary sonar is installed 
on the port side. If side scan is enabled, the image displayed is that from the two sonar systems 
combined. All setting changes apply to both systems, unless the Unlinked mode is checked. 

9. Frequency Separation: The transmit frequencies must not overlap. When 2 sonars are selected, the 
GUI automatically applies a frequency separation. When a center frequency is defined, 40kHz 
bandwidth is applied by default, since the sonars are optimized for a total bandwidth of 80kHz. For 
example, when 400kHz is selected with the default bandwidth of 40kHz, the sonars ping through a 
total frequency range of 360kHz-440kHz, with one sonar transmitting from 360kHz to 400kHz, and the 
second sonar transmitting from 400kHz to 440kHz. This allows the sonars to ping in sync without 
interference. To change the frequency spread, adjust the Resolution slider under Tx Pulse Settings. 

10. Port Numbers: In the acquisition software, the default port number is 7000 for primary and 7001 for 
secondary. The secondary port is always one greater than the primary. Some packages give the option 
to select one head as primary and one as secondary. In this case, both heads are primary. 

 

 

WBMS Bracket (±37.5° roll) 

WINGHEAD Bracket 

(±10° roll, ±1° pitch) 
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Appendix C: Sonar Hardware Dimensions 

C1. WINGHEAD B41 & i77h – Wet-End Dimensions Excluding Bracket (PN 24103) 
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C2. WINGHEAD B41 & i77h – Wet-End Dimensions Including Bracket (PN 24103) 
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C3. WINGHEAD B41 & i77h – Reference Points and Offsets (PN 24103) 
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C4. WINGHEAD B41 & i77h – Moon Pool Dimensions (PN 24103) 
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C5. 12004 iWBMS / 12007 iWBMSh – Wet-End Dimensions (PN 24003-ACDB) 
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C6. 12004 iWBMS / 12007 iWBMSh 0.9°Tx – Wet-End Dimensions (PN 24003-ABDB) 
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C7. 12006 iWBMSe – Wet-End Dimensions (PN 24005/24018)   
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C8. 12003 WBMS – Wet-End Dimensions (PN 24003-ACDB) 
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C9. 12003 WBMS 0.9° Tx – Wet-End Dimensions (PN 24003-ABDB) 
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C10. 12004 iWBMS / 12007 iWBMSh Long Range – Wet-End Dimensions (PN 24007) 
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C11. WINGHEAD Sonar Interface Unit (iSIU-WH) Dimensions (PN 29060) 
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C12. iWBMS Sonar Interface Unit (SIU-I-NAV) Dimensions (PN 29028) 
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C13. WBMS Sonar Interface Unit (SIU) Dimensions (PN 29024) 
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Appendix D: Pinout Diagrams 

D1. WINGHEAD Sonar Interface Unit (iSIU-WH) Socket Pin Description (PN 29060) 
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D2. iWBMS Sonar Interface Unit (SIU-I-NAV) Socket Pin Description (PN 29028) 
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D3. WBMS Sonar Interface Unit (SIU) Socket Pin Description (PN 29024) 
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D4. WINGHEAD Integrated Cable Pin Description (PN 33231) 
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D5. iWBMS Split Cable Pin Description (PN 33129) 
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D6. iWBMSe Interface Cable Pin Description (PN 33088) 
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D7. WBMS Interface Cable Pin Description (PN 33029) 
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D8. WBMS Interface Pigtail Deepsea Cable Pin Description (PN 33095) 
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D9. WBMS Interface Pigtail Angled Pin Description (PN 33205) 
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D10. WINGHEAD Bulkhead Pinout (PN 33327) 
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D11. WBMS Bulkhead Pinout (PN 33049) 
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D12. iWBMSe Bulkhead Pinout (PN 33169) 

 



 
 
 
 

 

Sonar User Manual                                            Contents September 11, 2020 
GUI: 10.4.8 / FW: 5.2.1   Page 98 of 103 

 

Appendix E: Mounting Bracket & Pole Dimensions 

E1. iWBMS Decoupled IMU Mounting Bracket (PN 45654) 
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E2. Dual Head Bracket with WINGHEAD - Dimensions 
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E3. Dual Head Bracket with WINGHEAD – Offsets 
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E4. Dual Head Bracket with iWBMSe - Dimensions 

 



 
 
 
 

 

Sonar User Manual                                            Contents September 11, 2020 
GUI: 10.4.8 / FW: 5.2.1   Page 102 of 103 

 

E5. Dual Head Bracket with iWBMS / iWBMSh - Offsets 
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E6. NORBIT Carbon Fiber PORTUS Pole 

 

 

 

 

 

 

 

 


